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Introduction

Woelcome to the Material Library, an add-on product that provides predefined
material data, primarily as piecewise polynomial functions of temperature. The
Material Library contains more than 84,000 property functions; these functions
specify various material properties of over 10,000 materials.

The Material Library is ideal for multiphysics couplings such as electrical-thermal
analysis and structural-thermal analysis because most of the properties are available
as functions of temperature.
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The Material Library Environment

When working with the Material Library, it is the same as working with any other
material database. Below are descriptions about the predefined material databases, the
Material Library folders, and the windows and pages you work in to add any material

to your model.

See Materials in the COMSOL Multiphysics Reference Manual for an
@t overview of working with material properties, material databases, and the

Material Browser.

About the Material Library

The Material Library stores the material data in folders. A search engine on the Material
Browser makes it easy to find materials to add to models — you can search by name,
UNS number, or DIN number.

The following is some basic information about the available material properties

contained in the Material Library.
e The Material Library incorporates mechanical, thermal, and electrical properties
primarily for solid materials.

* The material properties are described as a function of some variable, typically

temperature, and focus on elastic and thermal properties.

* Where applicable, data is given for a material’s solid, liquid, and vapor phases. A

material can also contain data for multiple orientations or variations.
¢ The properties are analytic functions over a given interval of the argument.

* Smoothing is used to interpolate the values of the properties between different
intervals. You can choose the smoothing settings in order to obtain continuous first

and second derivatives of the property functions.

e Materials can be copied to a User-Defined Library where you can add and edit

properties. You can also plot and inspect the definition of a function.

¢ The material property data in the Material Library is based on the Material Property
Database (MPDB) from JAHM Software, Inc.

* For all properties contained in the Material Library, you can view the literature

reference, notes, and reference temperature (where applicable) by first selecting a
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material property and then on the Material Browser, under Properties, click a specific

property. Then information, when available, displays under Property reference.

* Working with Materials
@ll e The Material Browser Window
¢ The Add Material Window

Where Do I Access the Documentation and Application Libraries?

A number of internet resources have more information about COMSOL, including
licensing and technical information. The electronic documentation, topic-based (or
context-based) help, and the application libraries are all accessed through the
COMSOL Desktop.

If you are reading the documentation as a PDF file on your computer,
the blue links do not work to open an application or content

n referenced in a different guide. However, if you are using the Help
system in COMSOL Multiphysics, these links work to open other

modules, application examples, and documentation sets.

THE DOCUMENTATION AND ONLINE HELP

The COMSOL Multiphysics Refevence Manual describes the core physics interfaces
and functionality included with the COMSOL Multiphysics license. This book also has
instructions about how to use COMSOL Multiphysics and how to access the
electronic Documentation and Help content.

Opening Topic-Based Help
The Help window is useful as it is connected to the features in the COMSOL Desktop.
To learn more about a node in the Model Builder, or a window on the Desktop, click

to highlight a node or window, then press F1 to open the Help window, which then

THE MATERIAL LIBRARY ENVIRONMENT
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displays information about that feature (or click a node in the Model Builder followed
by the Help button ( [ ). This is called topic-based (or context) help.

To open the Help window:
* In the Model Builder, Application Builder, or Physics Builder click a node or
window and then press F1.

* On any toolbar (for example, Home, Definitions, or Geometry), hover the
Win mouse over a button (for example, Add Physics or Build All) and then
press F1.

* From the File menu, click Help ( | )-

* Inthe upper-right corner of the COMSOL Desktop, click the Help ( | )
button.

To open the Help window:

¢ In the Model Builder or Physics Builder click a node or window and then
press F1.

* On the main toolbar, click the Help ( [g ) button.

* From the main menu, select Help>Help.

Opening the Documentation Window

To open the Documentation window:

Win e DPress Ctrl+F1.

¢ From the File menu select Help>Documentation ( I! ).

To open the Documentation window:

e DPress Ctrl+F1.

* On the main toolbar, click the Documentation ( [JJj ) button.
Linux

e From the main menu, select Help>Documentation.

INTRODUCTION



THE APPLICATION LIBRARIES WINDOW

Each model or application includes documentation with the theoretical background
and step-by-step instructions to create a model or application. The models and
applications are available in COMSOL Multiphysics as MPH files that you can open
for further investigation. You can use the step-by-step instructions and the actual
models as templates for your own modeling. In most models, SI units are used to
describe the relevant properties, parameters, and dimensions, but other unit systems
are available.

Once the Application Libraries window is opened, you can search by name or browse
under a module folder name. Click to view a summary of the model or application and
its properties, including options to open it or its associated PDF document.

The Application Libraries Window in the COMSOL Multiphysics
Q@ Reference Manual.

Opening the Application Libraries Window
To open the Application Libraries window ( [[[|] ):

¢ From the Home toolbar, Windows menu, click ( |]]]] ) Applications

Libraries.

Win ¢ From the File menu select Application Libraries.

To include the latest versions of model examples, from the File>Help
menu, select ( EF”'j ) Update COMSOL Application Library.

To include the latest versions of model examples, from the Help menu
Linux select ( m ) Update COMSOL Application Library.

Select Application Libraries from the main File> or Windows> menus.

CONTACTING COMSOL BY EMAIL

For general product information, contact COMSOL at info@comsol.com.

COMSOL ACCESS AND TECHNICAL SUPPORT
To receive technical support from COMSOL for the COMSOL products, please
contact your local COMSOL representative or send your questions to

THE MATERIAL LIBRARY ENVIRONMENT
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support@comsol.com. An automatic notification and a case number are sent to you by

email. You can also access technical support, software updates, license information, and

other resources by registering for a COMSOL Access account.

COMSOL ONLINE RESOURCES

COMSOL website
Contact COMSOL
COMSOL Access
Support Center
Product Download
Product Updates
COMSOL Blog
Discussion Forum
Events

COMSOL Application Gallery
COMSOL Video Gallery

Support Knowledge Base

www.comsol.com
www.comsol.com/contact
www.comsol.com/access
www.comsol.com/support
www.comsol.com/product-download
www.comsol.com/support,/updates
www.comsol.com/blogs
www.comsol.com/community
www.comsol.com/events
www.comsol.com/models
www.comsol.com/video

www.comsol.com/support,/knowledgebase

INTRODUCTION


https://www.comsol.com
https://www.comsol.com/contact/
https://www.comsol.com/access
https://www.comsol.com/support/
https://www.comsol.com/product-download/
https://www.comsol.com/support/updates
https://www.comsol.com/blogs/
https://www.comsol.com/community
https://www.comsol.com/events/
https://www.comsol.com/models/
https://www.comsol.com/video/
https://www.comsol.com/support/knowledgebase/

Using the Material Library

This chapter describes the material properties in the Material Library and how to
use them in your COMSOL Multiphysics® models. It also contains information
about using functions to define material properties.

In this chapter:
* Working with Materials
* Material Properties

¢ Other Material Properties Reference

* Using Functions



12 |

Working with Materials

The Material Browser Window

The Material Browser window ([:i:] ) contains a number of databases with a broad
collection of elastic, solid mechanics, electromagnetic, fluid, chemical, thermal,
piezoelectric, and piezoresistive properties of materials. The number of material
databases depends on which COMSOL products your license includes. Use the
Material Browser to find predefined materials and add them to the Model Builder, or

create a custom material library.

To open the Material Browser [::]:

¢ On the Materials toolbar, click Browse Materials.
* Right-click the Materials node ( 32z ), and then select Browse Materials.

¢ From the Home toolbar, select Windows>Material Browser.

To open the Material Browser [:]:

* On the Model Toolbar, click Browse Materials.

* Right-click the Materials node ( 52z ), and then select Browse Materials.
Linux

¢ Seclect Windows>Material Browser.

CHAPTER 2:

The Material Browser is similar to The Add Material Window but it includes detailed
property information about each material. From this window you can also create a new
material library and import a material library. See Adding Materials to a Component
for information about adding materials to your model’s components (geometries).
Click Done ( [+ ) to close the Material Browser and add the materials in the Added to
model list to the model. Click Cancel ( €3 ), press Escape, or click in the main toolbar

to exit the Material Browser without adding any materials.

Right-click a material library in the Material Browser and choose Reload Selected (¥ )
to clear all cached data for that library and force the COMSOL Multiphysics software
to reload the content from the file system. This operation is useful, for example, if the
library is a user-defined library that has been edited since the COMSOL Multiphysics

session started and needs to be reloaded to display the latest contents.

USING THE MATERIAL LIBRARY



You can browse all of the available material databases or search for specific materials.

There is also a Recent Materials folder where you find the most recently used

-}
materials. Search a specific material by name (or, for the Material Library product, by
UNS number or DIN number, which are listed in the Material Browser when

available).

When browsing the material databases, in particular the Material Library, some
materials include additional information — UNS number, DIN number, and

composition.

As in Figure 2-1, the following information is included in the window to the right of
the material tree. Navigate in the material tree and click a material to display the
information.

Material availability is based on the type of COMSOL Multiphysics
2 license. For example, if you have the MEMS Module, you have the

Built-In, Liquids and Gases, MEMS, and Piezoelectric material libraries.

PROPERTIES

While browsing the databases, predefined material properties for the selected material
are listed in a table in the columns Property, Expression, Unit, and the Property group to
which the material property belongs. If Property group is empty, the material property

is a Basic property.

Under Property reference, for the materials in the Material Library product, reference

information about a material’s properties appears when you click a property above.

INPUTS

For some materials, predefined function inputs are listed in a table in the columns
Input, Variable, and Unit. Inputs appear for material properties defined using functions
that require the input. Typical inputs are temperature and pressure, for temperature-

and pressure-dependent material properties, respectively.

CREATE A NEW MATERIAL LIBRARY OR IMPORT A MATERIAL LIBRARY
Click the New Material Library button (lg[l) to open the New Material Library dialog
box. You can also right-click a material and select Add to New Library ( [|II ) to create a
new material library and add that material to the new library. Go to Creating a New
Material Library and Adding and Editing Materials in the COMSOL Multiphysics
Reference Manual.

WORKING WITH MATERIALS
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Click the Import Material Library button (=) to open the Choose Material Library

dialog box. You can also click the downward-pointing arrow to the right of the Import

Material Library button and choose Import Material From ([T ) to open the fullscreen

Select Material window and choose the material from a database. Go to Importing a
Material Library in the COMSOL Multiphysics Reference Manual.

Material Browser

Search

4 [ Material Library
4 [ Elements

45 Add to Component

== Hydrogen
Helium
Lithium
2 Beryllium
Boron
% Nitragen
== Oxygen
Fluorine
Neon
Sodium
2= Magnesium
Aluminum
2= Silicon

£ W

sa v Add To

Added to modek:

Remove

Help eCan:e\ D\/Done

Figure 2-1: The Material Browser details o material’s properties after selection. In this
example, the properties of Oxygen are listed to the right of the Material Browser folders.

CHAPTER 2:

USING THE MATERIAL LIBRARY

Material: Oxygen
Phase: liquid

Orientation/variation:

Properties
"
Property Expression Unit
Thermal conductivity ke liquid _1(TI1/KDIW... W/ m*K)
Coefficient of thermal expa... | (alpha(T[1/K[1/K]+(.. | 1/K
VP VP(T[1/K])[Pa]
Density rho_liquid_1(T[1/K][... |kg/m*"3
Dynamic viscosity eta_liquid_1(T[1/K])[P... Pa*s
(dL(T[1/K]}-dL{Termpr... 1
(dL{T[1/K])-dL(Tempr... 1
CTE(T[1/KD[1/K] WK
CTRTIAKTI K IS

Property group

Thermal strain Thermal expansion
Isotropic thermal strain
Tangent coefficient of ther...

lentranic tannent refficie

Thermal expansion
Thermal expansion
Thermal evnancinn
Property reference:

Select a property in the list above to display its reference.

Inputs
H

Input Variable Unit
Temperature T K
Yolume reference temperature Tempref K



MATERIAL LIBRARY FOLDERS

TABLE 2-1: MATERIAL LIBRARY FOLDERS

FOLDER

Elements

Iron Alloys

Nickel Alloys

Copper Alloys

Controlled Expansion Alloys
Aluminum Alloys

Magnesium Alloys

Titanium Alloys

Simple Oxides

Complex Oxides/Silicates
Carbides

Cermets

Tool Steels

Carbons

Thermal Insulators
Intermetallics

Refractory Metal Alloys
Thermal Barrier Coatings
Nylons and PA/PI (polyamides)
PAI (polyamide-imide)

PPA (polyphthalamides)
Polyethers and Polyesters

PEl (polyetherimide)

PARA (polyarylamide)

PLS (polylactic acid)
Acetal/POM (polyoxymethylene)
PVDF (poly(vinylidene fluoride))
EVA (ethylene-vinyl acetate)
PC (polycarbonates)

TPU (thermoset polyurethanes)

WORKING WITH MATERIALS
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TABLE 2-1: MATERIAL LIBRARY FOLDERS

FOLDER

Miscellaneous Polymers

Miscellaneous Polymer Composites
Elastomers

Epoxies

Minerals, Rocks, and Soils

Woods

PP (polypropylenes)

PET (polyethylene terephthalate)

PBT (polybutylene terephthalate)
ECTFE (polyethylene chlorotrifluoroethylene)
PFA and ETFE (fluorocarbons)

m-PPE and PPE/PA

ABS (acrylonitrile butadiene styrene)
PAEK and PEEK (polyaryletherketone)
PSU (polysulfone)

PES/PESU (polyethersulfone)
PPSU/PPSF (polyphenysulfone)

Zinc Alloys

Solders, Brazes, Low Melting, and Dental Alloys
Precious Metal Alloys

Thermocouple Alloys

Semiconductors and Optical Materials
Organics and Hydrocarbons

Foods

Other Materials

Cobalt Alloys

Resistance Alloys

Magnetic Alloys

Metal Matrix Composites

Ceramic Matrix Composites

Salts (single component)

16 | CHAPTER 2: USING THE MATERIAL LIBRARY



TABLE 2-1: MATERIAL LIBRARY FOLDERS

FOLDER

Salts (multicomponent)

Salts (binary mixtures)

Salts (ternary mixtures)

Fuel Cell, Battery, and Electro-ceramics
Silicides

Borides

Glasses and Metallic Glasses

Nitrides

Cast Irons

Mold Materials

The Add Material Window

The Add Material window is similar to The Material Browser Window. It has the same
material libraries available but does not include the detailed properties about each
material. The number of material libraries depends on which COMSOL Multiphysics

products your license includes. This window is a quick way to add materials to models.

To open the Add Material window

o

¢ From the Materials toolbar, click Add Material.

* Right-click the Materials node ( % ) and select Add Material from Library.

Asin Figure 2-2you can browse all the available material databases or search for specific
materials. There is also a Recent Materials folder where you find the most recently used

materials. Search a specific material by name (or, for the Material Library product, by
UNS number or DIN number).

WORKING WITH MATERIALS
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Add Materia =3
(7)) Add to Global Materials v =+ Add to Component ~

Search

425 Recent Materials
4 [ Material Library
4 [ Elernents

I [ Hydrogen
I [ Helium
I [ Lithium
I [ Beryllium
I [ Boron
I [ Mitrogen
4 [} Oxygen
=& Oxygen [liquid]
22 Oxygen [vapor]
b [ Oxygen [gas]
22 Oxygen [solid]
[ Fluorine
[ Meon
[ Sedium
[ Magnesium
[ Aluminum

Figure 2-2: The Add Material window. In this example, the liquid phase of Oxygen is
selected and can be added to the Material node in the local Component or as a global
material in the Model Builder.

Adding Materials to a Component

You can add materials to Component nodes using either the Add Material or Material
Browser windows. In either window, use the Search field to find materials by name,
UNS number, or DIN number. Or click any of the folders and subfolders to locate and
add a specific material. To add a material to the current component, click the Add to
Component button, right-click the material and choose Add to Component, or, in the
Add Material window, press Enter. In the Add Material window you can also add a
material to global Materials list and to the current selection. In the Material Browser
window, you can also add the material to the global Materials list and to an existing
user-defined or new material library.

USING THE MATERIAL LIBRARY



For example, click the arrow to the left of Elements to expand that folder, and then click

Oxygen.

In the Add Material window, all the materials are listed with a description
of the phase and orientation /type next to the primary name (for example,

Oxygen [liquid], Oxygen [vapor]. This is different in the Material Browser,

i

where you select these options from the Phase or Orientation/variation

lists.

Using the Add Material Window
I Open the Add Material window (see The Add Material Window).

2 In the Add Material window, select a material by phase (liquid, vapor, gas, or solid)

and orientation /variation, when available.

3 Click the Add to Global Materials or Add to Component buttons, or right-click the
material and select the same options from the context menu. If there is more than

one Component node in the model tree, add the material to the applicable geometry.
- Click the Add to Global Materials button to add it under the global Materials node.

- Click the Add to Component button to add the material to the active component
in the Model Builder and then make it an active material in the domains (or other
geometric entities) where it is selected. You can also select any of the components
in the model to add it to its Materials node, or select Add to Switch I, for example,
to add it under a Switch node for materials under the global Materials node.
Right-click the Material node to rename it, for example, using the name of the

material it represents.

Using the Material Browser Window
I Open the Material Browser window (see The Material Browser Window).

2 In the Material Browser, sclect options from the Phase and Orientation/variation lists,
when available (only included for some materials in the Material Library product).
In this window you can review the material Properties and Input sections. See
Viewing Material Property Information for information about viewing information

about, for example, references for a specific material property.

3 Click the Add to Component button ( % ) under the list of materials to add the
selected material to the current model component. Alternatively, click the Add To
button ( =35~ ) to add the material to the global Materials node (choose Global
Materials), to any available model component, or to an existing or new user-defined

material library. You can also right-click the selected material node to add that

WORKING WITH MATERIALS
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material to a model component or user-defined material library. Materials that you
have selected to add to any of the model components appear in the Added to model
list.

4 Click Done ( [/ ) to add the materials to the model tree in the Model Builder and close
the Material Browser. If it is the first material in that model component, the material
in the Model Builder becomes the default material; otherwise, the material is initially
not used anywhere but becomes the active material in the domains (or other

geometric entities) that you pick to add to that material’s selection list.

Merging o Material With Another Material

You can merge a material with another material. The other material, with which that
material is merged, then inherits all material properties from the material that you

merge. If both materials include the same material properties, then the values of those
material properties in the material that you merge with another material are used in the
other, remaining material. The Material node for the node that you merge with another

material is removed from the model tree. To merge a material, do the following steps:

I Right-click the Material node for the material that you want to merge with another

material in the model.

2 From the Merge With context menu, choose one of the materials in the same folder
(under Global Materials, or under Materials in a Component), or choose a material

from another folder.

3 The material is then merged with the material that you selected from the Merge With
menu. The material property values from this Material node is then used in the other
material, and the original material property values are overwritten if both materials

included some common material properties. This Material node is removed.

You can also use the Merge With menu (325 ) on the Materials toolbar.

Importing and Exporting Materials

You can import and export materials to and from your COMSOL Multiphysics
models. The Materials toolbar include Import Materials and Export Materials buttons.
You can also right-click one of the following nodes in the Model Builder and choose

Import Materials, Import Materials From, or Export Materials:

¢ The Materials node under Global Definitions.

USING THE MATERIAL LIBRARY



* The Materials node under Definitions in a component.

e Any node group under those branches.

The selected node determines where the imported materials will go or what materials
to export into a new XML-file.

To import materials first select one of these nodes, then click the Import Materials
button or choose it from a context menu. An Import Materials dialog appears that
displays the content of the selected file. Select the materials to import and then click

OK to import them to the model. You can also choose Import Materials From, which

opens the Select Model fullscreen window for choosing a materials file from a database.

Some types of materials can only be imported to either Global Definitions

or Definitions. Importing such a materials to the wrong branch is not

m

allowed, so they are therefore ignored in the import. A message will

appear when this happens.

To export materials, click the Export Materials button or choose it from a context
menu. In the Export Materials dialog box that appears, choose the file location and
enter a name for the XML-file to export materials to. Click OK when you are done to

export the materials in the chosen file.

MATERIAL IMPORT AND EXPORT FORMATS

COMSOL can import materials from the following formats:

e MPH files.

* Model XML-file format.

e A special XML-file format (JmatPro XML) for metal processing.

There are no special extension for the supported XML-file formats, and they expect

the .xml extension. The COMSOL Multiphysics software detects the actual format
automatically by looking at the first part of the file.

For materials export, COMSOL Multiphysics only supports explicit export to the
Model XML-file format. You can export materials on the MPH-file format by just

saving a model, which can contain materials only.

WORKING WITH MATERIALS
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For more information about the XML-file format, see Materials in The COMSOL File
Formats chapter in the COMSOL Multiphysics Programming Reference Manual.

To see how a material is stored in the Model XML-file format, you can
fm export it from the COMSOL Desktop and then open the resulting
XML-file to see the XML content for the exported materials.

CHAPTER 2:

Materials

Use the nodes under Materials ( % ) to add predefined or user-defined materials,
including layered materials and porous materials, to specify material properties using
model inputs, functions, values, and expressions as needed, or to create a custom
material library. Also see Material Link, Switch for Materials, Working with External
Materials, About the Material Libraries, Layered Material, Layered Material Link,
Layered Material Stack, Single-Layer Materials, Porous Material, and Topology Link
in the COMSOL Multiphysics Reference Manual.

You can right-click the Materials node and select Add Material from Library to add a
material using The Add Material Window or select Browse Materials to open The
Material Browser Window for more thorough information about the available
materials in the material libraries. You can also select Blank Material to add a Material

node with no predefined material properties.

MATERIAL OVERVIEW
This section provides an overview of the materials in the Component node and where
they are used. You can also add materials under Global Definitions. To access such global

materials in a model component, use a Material Link.

The Material column lists the current materials in the Component using the materials’
node labels from the model tree according to the settings defined in Displaying Node
Names, Tags, and Types in the Model Builder.

The Selection column lists the geometric entities selected for the material (the domains,

boundaries, or edges where the material is defined).

ERRORS RELATING TO THE MATERIAL NODES

If a material property in a physics interface takes its value from a material and no
material is defined for the same geometric selection, a stop sign ( (5 ) displays in the
leftmost column and the Material column contains Entities needing a material. The

Selection column contains the geometric entities in which a material definition is
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missing. The Materials node also indicates when there is a material error (see
Figure 2-3). For example, if some property is deleted but needed in a part of the

geometry, then the icon indicates where the error is located.

Maodel Builder ~ 4| Settings
« = ETE =~ Materials
4 & Untitled.mph (root)
4 () Global Definitions * Material Overview
Fi Parameters 1 "
22 Materials Material Selection
4 @ Component 1 {comp1) @ |Entities needing a material Domain 1
[ = Definitions
b YA Geometry 1

i Materials
I» {[E Heat Transfer in Solids (ht)
A5 Mesh 1
4 ~db Study 1
E Step 1: Stationary
[fr. Solver Configurations
EJ Job Configurations

b {8 Results

Figure 2-3: An example of a Materials node error.

Grouping of Materials for User-Defined Materials

When creating materials for a user-defined material, you can add Group nodes to
create folders in the material library or to define a phase or a phase and orientation in

the Material Library Settings section.

MATERIAL LIBRARY SETTINGS

Select the Material Library Settings check box in the Show More Options
= dialog box to display this section.

From the Group type list, choose one of the following options:

* Library folder (the default), to use the Group node’s label as a library folder for
organizing the material library into groups of material.

* Phase, to use the group for defining variations of a material with different material
phases and possibly also orientation or variation. You define those properties in the
Material subnodes’ Material Library Settings sections.

* Phase and orientation, to use the group for materials with a certain phase and
different orientation or variation. You define the orientation or variation in the
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Material subnodes’ Material Library Settings sections. From the Phase list, choose

Custom, Solid, Liquid, or Gas to define the phase of the materials in this group.

The Settings Window for Material

The Settings window for Material ( :f: ) summarizes the predefined or user-defined
material properties for a material. This is where you can add or change material
properties to fit your model and assign the material to all types of geometric entities:
domains (most common), boundaries, edges (3D models only), or points. Also see
Material Link and Switch for Materials.

After adding a material (see The Add Material Window and The Material Browser
Window), click the Material node (for example, Material 1 or Copper) in the Model
Builder. The Settings window for Material opens.

A standard Material node in the global component can turn into a layered material by
adding a Shell property group. After that, it can be linked by a Layered Material Link

In the Label field, enter a suitable label for the material. If you defined global materials
for a user-defined material library, the label becomes the name of the material. See also
Material Library Settings below. You can also use the Name field to change the identifier.
This setting also changes the tag and therefore makes it possible to control the scope

of variables and functions that the material defines.
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Material Contents
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Figure 2-4: Click the Copper node to open the Settings window for Material for the node.

GEOMETRIC ENTITY SELECTION

This section is available for materials in a component. Assign the material to some or
all entities on a specific Geometric entity level — Domain, Boundary, Edge (3D only), or
Point — on the geometry in the Graphics window (the geometry in the model).

By default, the first material in the Component is active in all domains (or
all boundaries or edges if the Component only contains surfaces or

edges). By assigning other materials to some or all domains, the first

i

material is overridden and remains active only in domains where no other
material, added below it in the Materials branch, is active.

If the Component contains features on different geometric entity levels,
such as solid mechanics in domains coupled to beams on edges, and the

features use the same material, you need to add two Material nodes with

m

the same material, one defined in the domains, and the other defined on

the edges.
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OVERRIDE
This section, available for materials in a component, shows if the material, in some or
all parts of the geometry where it is active, is overridden by another material added

underneath it in the Materials branch, or if it overrides another material above it.

The Overridden by list shows the names of the materials that override this material. The
Selection list in the Geometric Entity section displays (overridden) for the geometric

entities in which this material is overridden.

The Overrides list shows the names of the materials that this material overrides.

* Physics Exclusive and Contributing Node Types
@t * Physics and Variables Selection

* Physics Node Status

ORIENTATION AND POSITION

. This section only appears in Material nodes that are single layer material.
= See Single-Layer Materials.

CHAPTER 2:

Select a Coordinate system defining the principal directions of the laminate. Only

Boundary System coordinate systems can be selected.

Choose a Position — Midplane on boundary, Downside on boundary, Upside on boundary,
or User defined. This controls the possible offset of the material from the geometrical
boundary on which the mesh exists (the reference surface). For User defined, enter a
value for the Relative midplane offset. The value 1 corresponds to Downside on boundary,
and the value —1 corresponds to Upside on boundary. Values may be outside the range

-1 to 1, in which case the reference surface is outside the laminate.

The Position sctting is only used by physics features where the physical behavior

depends of the actual location, such as structural shells.

By clicking the Layer Cross Section Preview (=) button, you get a preview plot of the
single layer material, including the location of the reference surface. This plot looks
similar to Figure 2-10, but there is only a single layer. You can also click the downward
pointing arrow to choose Layer Cross Section Preview (== ) button or Create Layer Cross
Section Preview (=) button, which adds the preview plot as a new plot group under
Results.
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MATERIAL PROPERTIES

You can add material properties to the material if they are not already included. To do
so, browse the available material property categories (Basic Properties, Acoustics, and so
on), and select a material property or a collection of material properties in one of the
property groups or material models that appear under the main level of material
property categories. Right-click the material property or property group and select Add
to Material, or click the Add to Material button (-} ) to add the material property or

group of properties to the material.

Review the properties listed in the Material Contents table before adding

n new material properties.

For example, under Acoustics>Viscous Model sclect Bulk viscosity (muB) and right-click
to Add to Material or click the Add to Material button (- ). If you add a material model
like the Viscous Model with more than one property, all of its material properties are

added to the Material Contents table. In this example, a Viscous model node is added to

the Model Builder and its associated properties are added to the Material Contents table.

To delete a property group, right-click the property group node (in the
Model Builder) and sclect Delete ( := ). The Basic property group cannot be
deleted.

A Note About Adding Basic Material Properties
Material properties can be added to the Basic group or to any User-Defined Property
Group from two locations — the Settings windows for Material and Property Group.

¢ When material properties are added from the Basic node’s or a user-defined group
node’s Settings window for Property Group, they are listed under Output Properties

and Model Inputs in that Settings window.

¢ When material properties are added from the Settings window for Material, the
available material properties are listed under Material Properties and are added to the
list under Material Contents with the property group listed. The list under Material
Contents also contains material properties added from a subnode with a Settings

window for Property Group.

Material Type
The Material type setting decides how materials behave and how material properties are

interpreted when the mesh is deformed. Select Solid for materials whose properties
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change as functions of material strain, material orientation, and other variables
evaluated in a material reference configuration (material frame). Select Nonsolid for
materials whose properties are defined only as functions of the current local state at
each point in the spatial frame and for which no unique material reference

configuration can be defined.

Simply put, Selid materials associate material properties with specific pieces of the
material, and the properties follow the material as it moves around. In particular, a
solid material may be inherently anisotropic, meaning that its axes rotate together with
the material. The Nonsolid choice, in contrast, applies typically to liquids and gases
whose properties are associated with fixed points in space and insensitive to local
rotation of the material. Such materials are inherently isotropic when studied in
isolation but can exhibit anisotropy induced by external fields. In practice, this means
that any anisotropic tensor properties in a nonsolid material must be functions of some

external vector field.

MATERIAL CONTENTS

This section lists all of the material properties that are defined for the material or
required by the physics in the model. The table lists the Property, Variable, Value, and
Unit for the material property as well as the Property group to which the material
property belongs. The Property group corresponds to the subnodes in the Model Builder

with the same name. If required, edit the values or expression for the property’s Value.
The left column provides visual cues about the status of each property:

* Astop sign () indicates that an entry in the Value column is required. It means
that the material property is required by a physics feature in the model but is
undefined. When you enter a value in the Value column, the material property is

added to its property group.

* A warning sign ( ) ) indicates that the material property has been added to the
material but is still undefined. An entry is only required if the material property is to

be used in the model.

* A green check mark ([ ) indicates that the property has a Value and is currently
being used in the physics of the model.

* A synchronize symbol ( |_’£'| ) indicates that the property is computed and
synchronized using the given values for other material properties from which it can

be computed.

* Properties with no indication in the left column are defined but not currently used

by any physics in the model.
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You can change the value for any property that is not synchronized by editing its value
directly in the Value column, or, for a selected property, click the Edit button (@) or
right-click and choose Edit to enter a value in the window that opens. If the property
can be anisotropic, you can choose to enter the values in one of these forms: Isotropic,
Diagonal, Symmetric, or Full. The Variable column lists the variable names
corresponding to the degree of anisotropy. For example, for a symmetric electrical
conductivity, it contains {sigmal I, sigmal2, sigma22, sigmal3, sigma23, sigma 33};
sigmaij = sigmaji. For an isotropic electrical conductivity, it contains sigma_iso; sigmaii
= sigma_iso, sigmaij = 0, where sigma_iso is the name of the variable for the isotropic

electrical conductivity (available as, for example, mat1.def.sigma_iso).

You can right-click any defined material property in the table and choose Go to
Requesting Node; the focus in the model tree then moves to the node that requested
that material property. If there are more than one node that requests that material
property, a Go to Requesting Node dialog box appears, where you can choose which of
those nodes to go to. Also, for nodes such as Material Link and Layered Material Link,
you can right-click any defined material property and choose Go to Source to move to

the material node that is the source of that material property.

MATERIAL LIBRARY SETTINGS

Select the Material Library Settings check box in the Show More Options
2 dialog box to display this section for Material nodes under Global

Definitions.

In this section, you can define properties for materials in a user-defined material library

to create a set of materials with varying material phase and orientation or variation.

Click the Update the Label button ( () to update the label, which becomes the name

of the material in the user-defined material library.

From the Phase list, choose Custom, Solid, Liquid, or Gas to define the material’s phase.
This setting is not available if the parent Group node has its Group type sct to Phase and

orientation, in which case the phase is defined in that Group node’s settings.

In the Orientation/variation ficld, enter some orientation or variation that represent this

material.
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APPEARANCE
The settings in this section, available for materials in a component, make it possible to
control or change the default appearance of a material in the Graphics window when

working in the materials or physics parts of the model tree.

[ In 3D components, the material is rendered including color and texture
when Scene Light is active. In 2D models and in 3D components, when
Q Scene Light is turned off, only a change of color is visible.

CHAPTER 2:

The Material type list provides quick settings approximating the appearance of a
number of materials — Air, Aluminum, Brick, Concrete, Copper, Glass, Gold, Iron, Lead,
Magnesium, Oil, Plastic, Rock, Soil, Steel, Titanium, Water, Wood, and more. Select Custom
to make further adjustments of the specific settings for colors, texture, reflectance, and
so on. The default custom settings are inherited from the material selected last from
the Material type list. If you have chosen a family other than Custom, click the

Customize button to define a custom material.

Specular Color, Diffuse Color, and Ambient Color
For each of these properties, select a standard color from the list: Black, Blue, Cyan,
Gray, Green, Magenta, Red, White, or Yellow, or choose Custom button to define a custom

color from the color palette that becomes available underneath the list of colors.

The combination of Specular color, Diffuse color, and Ambient color gives a 3D object its

overall color:

* Specular color is the color of the light of a specular reflection (specular reflection is

the type of reflection that is characteristic of light reflected from a shiny surface).

* Diffuse color represents the true color of an object; it is perceived as the color of the
object itself rather than a reflection of the light. The diffuse color gets darker as the
surface points away from the light (shading). As with Ambient color, if there is a
texture, this is multiplied by the colors in the texture, otherwise it is as if it has a

white texture.

* Ambient color is the color of all the light that surrounds an object; it is the color seen
when an object is in low light. This color is what the object reflects when illuminated
by ambient light rather than direct light. Ambient color creates the effect of having
light hit the object equally from all directions. As with Diftuse color, if there is a
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texture, this is multiplied by the colors in the texture; otherwise, it is as if it has a

white texture.

For examples of specular, diffuse, and ambient light, which are related to
E}‘ these definitions, see About the 3D View Light Sources and Attributes in
the COMSOL Multiphysics Reference Manual.

Custom Basis for Brush Lines

Select the Custom basis for brush lines check box to define a custom coordinate basis
for the brush lines. The default values for the brush line axes represent the global
Cartesian coordinate system. Specify other x, y, and z coordinates for the Origin and
the xm-axis if desired. To specify other coordinates for the ym-axis, first select the

Specify ym-axis check box.

Normal Mapping

Select the Normal mapping check box to add normal vector noise and brush lines.
Normal mapping is a texture that disturbs the normals when calculating lighting on
the surface (also called bump mapping). This causes the surface to look rough and
textured. The default Normal vector noise scale and Normal vector noise frequency are
taken from the material. You can choose the type from the Noise type list: White noise

(a uniform distribution) or Simplex noise.
Enter other values as needed, or click to clear the Normal mapping check box.

* The Normal vector noise scale is the power of the noise texture. A high value creates

a stronger texture of the surface. A value between 0-1 is suitable.

¢ The Normal vector noise frequency is the size of the noise disturbances. A small value

creates smaller features on the texture. A value between 0-10 is suitable.

* Add brush lines if desired by choosing an option from the Brush lines list: No brush
lines (the default), Brush lines orthogonal to xm-axis, Brush lines orthogonal to
ym-axis, Brush lines orthogonal to zm-axis, Brush lines along xm-axis, Brush lines along
ym-axis, Brush lines along zm-axis, Brush lines around xm-axis, Brush lines around

ym-axis, Brush lines around zm-axis, or Brush lines around origin.

The “m” in xm, ym, and zm above represents that the coordinates are with

L]
E respect to the material basis (custom basis).
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Additional Color

Select the Additional color check box if you want to blend the appearance with an
additional color that is added on the surface using noise. The settings are similar to
those for the normal mapping above, but you can also choose the color to add from
the Color list and choose a Color blend between 0 and 1. The Noise color is a parameter

that affects the appearance of the added color.

Opacity
The default Opacity is 1.

Lighting Model
The default Lighting model — Blinn-Phong or Cook-Torrance — is based on the material.

Select Simple instead as needed; it has no additional settings.

The different lighting models provide a set of techniques used to calculate the
reflection of light from surfaces to create the appropriate shading. For example, a
specular highlight is the bright spot of light that appears on shiny objects when
illuminated. Specular highlights are important in 3D computer graphics because they
provide a strong visual cue for the shape of an object and its location with respect to

light sources in the scene.

For Blinn-Phong, the default Specular exponent is 64. The specular exponent determines
the size of the specular highlight. Typical values for this property range from 1 to 500,
with normal objects having values in the range 5 to 20. This model is particularly useful

for representing shiny materials.

For Cook-Torrance, the default settings are taken from the material. The Cook—
Torrance lighting model accounts for wavelength and color shifting and is a general
model for rough surfaces. It is targeted at metals and plastics, although it can also

represent many other materials, and it includes the following settings.
e The Reflectance at normal incidence value is the amount of incoming light from the
normal direction (of the surface) that is reflected.

e The Surface roughness is a value that describes microreflectance on the surface.

Higher values create a rougher look of the surface with fewer highlights.

* The Metallic parameter is a value that affects how metallic the material appears to be.
A less metallic material reflects less of the environment. A nonmetallic material

cannot reflect the environment

* The Pearl parameter is an artificial effect that mimics the colors of a pearl.
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* The Diffuse wrap value gives an artificial effect that you can use to emulate subsurface

scattering.

¢ The Clear coat parameter is an artificial effect that makes surfaces that are parallel to
the view direction more white. It also adds specular highlighting and reduces the
effect on the environment reflections from the normal mapping.

¢ The Reflectance value is an additional setting that affects how much of the

environment that is reflected.

.You can enter these values in the respective text fields; alternatively, use the sliders
underneath each text field to adjust those values between 0 and 1. If you use the

sliders, the material appearance is updated directly.

Property Groups

The Settings window for Property Group is where output properties and model inputs
are added, local properties are defined, and expressions for material properties are

entered in a specific property group such as Basic. The property groups are subnodes
to a material node. The Settings window for Property Group is displayed when you click
the property group node (for example, Basic) under the material node (typically with

the material’s name — Aluminum, for example) in the Model Builder.
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2i Linearized resistivity (ltr)

Settings v
Property Group
Label: Basic =
¥ Output Properties
" Property Variable  Expression Unit Size  Info
Relative permeability | mur_iso.. |1 1 33
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Density rho 8960[kg/m"3] kg/m® 1xl
Thermal conductivity | k_iso; ki.. | 400[W/{m*K]] WimK) | 33
+ v
Expression:
* Model Inputs
" Physical quantity Variable

+
Local Properties
Figure 2-5: An example of a Basic Settings window for Property Group.

A property group under a material creates the following variables:

TABLE 2-2: VARIABLES GENERATED FROM A PROPERTY GROUP

CHAPTER 2:

TYPE VARIABLE NAME SCOPE SELECTION EXAMPLE
Basic Variable name root.material Material selection root.material.
property  of physical rho
quantity
root. <comp>. Global selection root.compi.

<mat>.<group>

mati.def.rho
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TABLE 2-2: VARIABLES GENERATED FROM A PROPERTY GROUP

TYPE VARIABLE NAME ~ SCOPE SELECTION EXAMPLE
Output Property name  root.material  Material selection root.material.
property .group linzRes.alpha
root. <comp>. Global selection root.comp1.
<mat>.<group> mati1.linzRes.
alpha

In the Label field, enter a suitable label for the property group if needed. You can also
use the Name field to change the identifier. This setting also changes the tag — except
for the Basic property group, where it is always def — and therefore makes it possible
to control the scope of variables and functions that the property group defines. You

can, for example, make the identifier shorter.

OUTPUT PROPERTIES
The predefined material properties in the property group appear in a table in the

Output Properties section.

It is only possible to add, move, and delete output properties from the

= Basic material properties and with user-defined property groups.

Click the Add button (-} ) to add another output property, which you choose from

one of the available physical quantities in the Physical Quantity dialog box that opens.

If required, edit the expressions in the list’s Expression column. Edit directly in the
table or in the Expression ficld underneath the table. You can insert predefined
expressions by clicking the Insert Expression button (IE|:I) or clicking Ctrl+Space and
then choosing an expression from the list of predefined expressions. You can also click
the Edit button (@ ), which opens a dialog box for easier specification of orthotropic
and anisotropic material properties (tensors), when applicable. Select Isotropic,
Diagonal, Symmetric, or Full when entering the data in the material property’s dialog
box. In the Expression column, use a syntax with curly braces such as

{k11, k21, k31, k12, k22, k32, k13, k23, k33} to enter anisotropic material
propertics for a 3-by-3 tensor k;; in the order k1, ko1, k31, k12, k22, 39, %13, k23, and
k3s. 1,2, and 3 represent the first, second, and third direction in the active coordinate
system. In many cases (for example, when entering the elasticity matrix for structural
mechanics), the matrix must for physical reasons be symmetric. The upper diagonal
part of the matrix you enter will then be mirrored when forming the actual constitutive

matrix, and the lower diagonal part is ignored.
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The Variable column lists the variable names depending on the type of anisotropy. For

an isotropic &, k_1iso represents its single scalar value.

The Unit and Size columns provide information about the unit and size of the output
property. The size is 1x1 for a scalar value such as density and 3x3 for a tensor (matrix)

quantity such as electrical conductivity.

If desired, you can add information about the property, such as references for its value
or expression. To do so, click the Edit/Show Property Information button ( (E] ) and
enter the property information in the dialog box that opens and then click OK. When
information is available for a property, and information symbol ( (i) ) appears in the

Info column.

Use the Move up ( + ), Move down (| ), and Delete ( :=; ) buttons to organize the
table as needed.

MODEL INPUTS

The model inputs are physical quantities, such as temperature, that are used as inputs
in the expressions that define the output properties (for example, to describe a
temperature-dependent physical quantity). For example, adding Temperature as a
model input with the variable name T makes it possible to use an expression for the
heat capacity at constant pressure C,, such as 300[J/ (kg*K) 1*T[1/K], which works
regardless of the name of the actual dependent variable for temperature in the model
that uses the temperature-dependent material. Without the model input, the

expression above only works with a temperature variable called T.

Click the Add button (-} ) to add another model input, which you choose from one
of the available physical quantities in the Physical Quantity dialog box that opens.

Use the Move up ( 1 ), Move down ( | ), and Delete ( := ) buttons to organize the

table as needed.

LOCAL PROPERTIES

Here you can enter a user-defined property by entering its variable name in the Name
column and its corresponding Expression and organizing the table as needed. You can
also enter a Description, which appears in the Property column in the Material Contents
section of the parent Material node. In that node, the Name entered here appears in the
Variable column. These local properties are useful for parameterizing functions that
describe material properties if they contain inputs other than those that are model

inputs (such as temperature and pressure). For example, a local property can be a
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reference value at a certain temperature. Use the Move up ( T ), Move down ( L ), and

Delete ( = ) buttons to organize the tables as needed.

You can use local properties to parameterize a material (for example, to
- create a generic “template” material for a particular symmetry class of
ril anisotropic materials). You can then adjust the local property values for

each instance of the material.

About Automatic Adding of Property Groups to a Material

Material property groups are automatically added to the material node in the Model
Builder. You can also add additional predefined property groups or create a User-Defined
Property Group (on the Materials toolbar, click User-defined Property Group ( ::: ) or
right-click the Material node). The available properties are collected in property groups
according to the physical context.

Each property group has a Settings window for Property Group. When a Model Builder
node is clicked (for example, Basic), the Settings window for Property Group displays
specific information about that property group. The physical properties for all property
groups are summarized in a Material Contents table on the Settings window for the

parent Material node.

Material Link

Add a Material Link node ( 272 ) under a Materials node in a model component to add a

link to a material that you have added under the global Materials node (/22 ) and use it

as a material in that component’s geometry. To add it, right-click the Materials node
and choose Material Link from the More Materials submenu. The Material Link node’s
Settings window is similar to the Settings window for a material node (see The Settings
Window for Material), with the exception that there is no Material Properties sections.

Instead, it includes the following section:
LINK SETTINGS
From the Material list, select the global material that you want to link to:

* Any global material node, to use that material in the component.
¢ Any Switch node, if you want to run a material sweep.

* None, to not link to any global material.
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Click the Go to Material button ( E:l ) to move to the selected material node. Click the
Add Material from Library button (-} ) to add a global material from the material
libraries or a new blank global material. The added material then becomes the one

selected in the Material list.

Switch for Materials

Use the Material Switch node ( ) to switch between materials during a solver sweep.
You add the materials as subnodes under the Material Switch node. Right-click to add
a Blank Material or select Add Material from Library to select materials from the libraries
in the Add Material window. You can also add a Layered Material or a Single Layer

Material.

The switch for materials essentially acts as a switch statement in a programming
language; that is, it dynamically selects one of'its underlying branches depending on a
parameter that can be controlled from the solvers, using a Material Sweep study. The
parameter name is constructed based on the tag of the Material Switch node, using the
special namespace matsw. For example, the parameter controlling a Switch node on the
global level will typically be matsw. sw1, while for a component-level Switch it will be
matsw.comp1.swi.

During a material sweep, the sweep parameter takes consecutive integer values, starting
from one, indicating which material under the switch that should currently provide
material properties. You can use the parameter name in conditional expressions to
control also other aspects of the model. Conversely, it is possible to control a material
Switch also by manually defining the full switch parameter name in a Parameters node.
You can then choose the parameter to sweep over in a standard Parametric Sweep node
or assign it different (integer) values in different parameter Case nodes and sweep using

a Parameter switch sweep.

The Material Switch node’s Settings window contains the following sections:

MATERIAL CONTENTS

This section lists all of the material properties that are defined for the material or
required by the physics in the model on domains where the Switch node is the active
domain material. The table lists the Property, Name, Value, and Unit for the material
property as well as the Property group to which the material property belongs. The
Property group corresponds to the subnodes in the Model Builder with the same name.

If required, edit the values or expression for the property’s Value.
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The list includes properties that are defined by any of the materials under the Switch

node. The left column provides visual cues about the status of each property:

* Astop sign () indicates that some subnode is missing a required Value. That is,
the material property is required by a physics feature in the model but is not defined

for all switch cases.

* A warning sign ( £}, ) indicates that the material property has been added to some

material subnode but is still undefined.

* A green check mark ([ ) indicates that the property has a Value in all subnodes and

is currently being used in the physics of the model.

APPEARANCE
The settings in this section make it possible to control or change the default appearance
of the material switch in the Graphics window when working in the materials or physics

parts of the model tree. See The Settings Window for Material for more information.

Layered Material

In the Layered Material node (7)), you can specify the properties of a multilayer
laminate. It is used when defining the properties of the following features:
e The Layered Shell interface (requires the Composite Materials Module).

* Layered Linear Elastic Material in the Shell interface (requires the Composite
Materials Module).

* Thin Layer in the Heat Transfer in Solids interface.
e The Heat Transfer in Shells interface (requires the Heat Transfer Module).
* The Electric Currents, Layered Shell interface (requires the AC/DC Module).

A Layered Material node can be present in two locations in the Model Builder:

e The most common place is under Global Definitions>Materials. When you reference
a layered material from a physics interface, you do it indirectly through either a
Layered Material Link or a Layered Material Link (Subnode) under Materials in the

current component.

It can also be a subnode under a Layered Material Stack node in a component.

LAYER DEFINITION
In this table you specify the properties of each layer.
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Click the Add button (-} ) to add another table row. Use the Move up ( T ), Move
down ( l ), and Delete (

reset the table to its default state, you can use the Reset to Default button (4—).

) buttons to organize the table as needed. To completely

——x

Conceptually, the layers are ordered from bottom to top of the laminate. Enter the

following data in the table:

Layer
Here you can assign a name to the layer for future reference. The default is a sequential

numbering: Layer 1, Layer 2, and so on.

Material

Select any available material. If the Layered Material node is located under Global
Definitions, the list contains only global materials. If the Layered Material node is used
as a subnode to a Layered Material Stack, also materials defined under Materials in the

component are available.
When you have a certain row in the table selected, you can access three shortcuts:

¢ Click the Blank Material ( =iz ) button to add a new blank material under global

materials. The material is referenced in current row of the Material column.

* Click the Add Material from Library ( :i: ) button to add a new material under global
materials from Material Libraries. The material is referenced in current row of the

Material column.

* Click the Go to Material ( 4 ) button to jump to the definition of the material

selected on the current row.

When you add a new row to the table, the same material as on the previous row is

selected. This means that if you have many, not adjacent, layers with the same material,
it is more efficient to initially add all layers with that same material. Then you can go
back and change the material for some layers. Alternatively, you can reorder the layers

using the Move up ( ) and Move down (| ) buttons.

Rotation

If the material in the layer is orthotropic or anisotropic, enter the angle in degrees
(positive counterclockwise) from the first principal axis of the laminate to the first
principal axis of the layer. Even for an isotropic material, the orientation can matter for
result presentation, since it affects the interpretation of for example stress tensor

components.
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Thickness
Enter the thickness of the layer (default unit: m). The thickness can be numeric value

or a scalar parameter.

Mesh Elements

In the physics interfaces, the layered materials are handled through the concept of a
virtual extra dimension. For a layered material defined on a boundary, you can think
of that as an extra coordinate in the normal direction. Enter the number of elements

that you want in the extra dimension for the layer.

INTERFACE PROPERTY

In some physics features, not only the layers themselves but also the interfaces between
them are important. In such a case, you can assign materials to the interfaces in this
table. The number of interfaces is one more than the number of layers because the free

top and bottom surfaces of the laminate are also considered as interfaces.

In most cases, you do not need to enter anything in this section.

Interface
This is the interface name, for future reference. As a default, the interface name is
constructed from the names of the two adjacent layers. For the top and bottom

interfaces, the labels “up” and “down” are used for the two exterior sides.

You can rename the interfaces. This is, however, seldom needed.

Position
This column shows the location of the interface. The distance is counted from the

bottom of the laminate. The column is for information only, and cannot be modified.

Material

Select the material of the interface. You only need to assign materials to the interfaces
that are explicitly referenced by physics features. The default is to take the material
From layer. The interface material properties are then computed from the adjacent

layers” material properties.
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Figure 2-6 shows an example of the settings for a layered material. The layer names

have been entered manually, whereas the interfaces have retained their default names.

Settings
Layered Material
Label: Layered Material 1 =
~ Layer Definition S HE=
" Layer Material Rotation  Thickness (m) Mesh elements
Bottomn Material 1 (matl) = |00 1.2E-4 2
Middle layer Material 2 (mat2)  « |45 2.3E-4 2
Top Material 1 (matl) ~ |60 34E-4 2
1 + ]

¥ Interface Property

" Interface Position (m) Material

Bottormn down OE0 MNone -
Bottom-Middle layer 1.2E-4 MNone A
Middle layer-Top 3.5E-4 MNone -
Top up 6.9000000000000... | None -

Figure 2-6: Settings for o material with three lnyers.

You can save the laminate definition to a text file by clicking the Save Layers to
File (L] ) button. For the example above, the text file has the following contents:

Bottom mat1 0.0 1.2E-4 2

"Middle layer" mat2 45 2.3E-4 2
Top mat1 60 3.4E-4 2
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To load a text file on this format, click the Load Layers from File ( = ) button. For
complex laminates, it may be easier to start by creating the text file representation in a
text editor, than to enter the data in the GUI.

When loading a file, the second column containing the material tag is
. ignored. The reason is that there is no way to ascertain that a material tag
ril like ‘mat2’ would point to the same material in another context. You can

even load a file where that column is absent.

You have two options for visualizing the laminate defined in the Layered Material node.
To see the thickness of each layer, click the Layer Cross Section Preview (== ) button.

This will give a plot like the one shown in Figure 2-7.

x107% T T T T T T T T T T T

161 .
14 .
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8r Top (Imatl)

Bottom (Imat1)

1 1 1 1 1 1 1 1 1 1 1

0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1

Figure 2-7: The layer cross section plot for a material with three layers.

You can also click the downward pointing arrow to choose Layer Cross Section Preview
(E==1) or Create Layer Cross Section Preview (=), which adds the preview plot as a new
plot group under Results. By clicking the Layer Cross Section Preview (== ) button, you
get a preview plot of the single layer material, including the location of the reference

surface. This plot looks similar to Figure 2-10, but there is only a single layer.
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To visualize the layer orientations, click the Layer Stack Preview (. 7) button. In
Figure 2-8, an example of such a plot is shown. The x-axis corresponds to the principal
laminate direction, and the stripes indicate the principal direction of each layer. You can
also click the downward pointing arrow to choose Layer Stack Preview (. 7 ) or Create
Layer Stack Preview (. ), which adds the preview plot as a new plot group under
Results. Click the Create Layer Stack Plot button (@J') to add the preview of the layer

stack as a new plot group under Results.

Figure 2-8: The layer stack preview plot for a material with three layers.

PREVIEW PLOT SETTINGS

In this section, you can fine-tune the display in the preview plots.

In the Distance between the orientation lines text field, you can enter a value for the
spacing of the stripes showing the orientation of the principal orientation of the layer.
The layer itself is always drawn as a square with the unity side length. If you clear the

corresponding check box, no orientation lines are drawn.
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The value of the Thickness-to-width ratio is used by both types of preview plots.

* In a layer stack preview plot, it controls the height of the stack in the z direction.
For laminates with many layers, you may need to increase this value.
* In the layer cross section preview plot, it controls the height in the y direction. The

width is always unity.

Clear the Shows labels in cross section plot check box to remove the text labels showing

layer names and materials.

Layered Material Link

The Layered Material Link node (I 1) provides a bridge from a Layered Material,
located under Global Definitions, toa physics feature residing in a component. A physics
feature designed to work with layered materials cannot directly reference a Layered
Material. The Layered Material Link node is located in the Layers submenu under a

Materials node.

LAYERED MATERIAL SETTINGS
Select a layered material from the Material list. You can also select a Switch for

Materials.

By clicking the Go to Material ( + ) button, you can jump to the settings for the

selected material.

Click the Add Layered Material button (-}~ ) to add another Layered Material or a Switch.

The added material then becomes the one selected in the Material list.
From the Transform list, choose one of the following options:

* None (the default), for no transformation.

* Symmetric or Antisymmetric, to create a symmetric or antisymmetric layered material
when the information of layers of one side of the midplane is supplied. Choose
which side to mirror in from the Mirror in list: Upside (the default) or Downside.
Upside means that the symmetry layers are on the top of the original layers. The
symmetry line is the top-side boundary. Downside means that the symmetry layers
are on the bottom of the original layers. The symmetry line is the bottom-side
boundary. Select the Merge middle layers check box to merge the two middle layers

into one to create an odd symmetric layer.

* Repeated, to create a number of repeating stacks, which you enter in the Number of
repeats ficld (default: 1).

WORKING WITH MATERIALS

45



46 |

Select the Scale check box to scale the layered material’s thickness with a factor
(default: 1).The scale can be a numerical value, a parameter, or an expression. Such an
expression can, for example, be a function of the coordinates so that a surface with
variable thickness can be described.

If a single layer in a laminate has a variable thickness, you can define that

layer in either a separate Layered Material or in a Single Layer Material.

* When using a Layered Material, apply the scaling expression in a Layered
Material Link, and then use a Layered Material Stack to build the

[

complete laminate.

* When using a Single Layer Material with an expression for the thickness,

use a Layered Material Stack to build the complete laminate.

If you have defined a layer with a scaling factor, it appears in the preview window with

a darker color than a nonscaled layer.

The preview is not shown in the base geometry space, so it will not show

= any geometrical dependency.

CHAPTER 2:

The labels of the newly created layers include a suffix to distinguish them from the

original layers:

e (sym) for the symmetric layers.
* (asym) for the antisymmetric layers.

¢ (repX) for the repeated layers (number X).

Click the Layer Cross Section Preview button (E= to plot a preview of the layer cross

section including the transformation (see the following plot for an example).

Layer 2 (rep2) (lImat1)

Layer 1 (limatl)

Figure 2-9: A vepeat laminated stacks with 2 times repeated layers.

USING THE MATERIAL LIBRARY



You can also click the downward pointing arrow to choose Layer Cross Section Preview
(E=1) or Create Layer Cross Section Preview (=), which adds the preview plot as a new

plot group under Results.

Click the Layer Stack Preview button () to get a preview of the stack with the

transformation.

ORIENTATION AND POSITION

Select a Coordinate system defining the principal directions of the laminate. The
orientation of each layer, given in the Layered Material node, is a rotation from the first
coordinate axis of this coordinate system. Only Boundary System coordinate systems

can be selected.

Choose a Position — Midplane on boundary, Down side on boundary, Up side on boundary,
or User defined. This controls the possible offset of the layered material from the
geometrical boundary on which the mesh exists (the reference surface). For User
defined, enter a value for the Relative midplane offset. The value 1 corresponds to Down
side on boundary, and the value —1 corresponds to Up side on boundary. Values can be

outside the range —1 to 1, in which case the reference surface is outside the laminate.

The Position setting is only used by physics features where the physical behavior

depends of the actual location, such as structural shells.

By clicking the Layer Cross Section Preview (== ) button, you get a preview plot of the
layered material, including the location of the reference surface (Figure 2-10). The
height of the laminate in the plot is controlled by the value of the Thickness-to-width
ratio specified in the Preview Plot Settings for the selected layered material. You can also
click the downward pointing arrow to choose Layer Cross Section Preview (=) or
Create Layer Cross Section Preview (=), which adds the preview plot as a new plot

group under Results.
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Figure 2-10: Layer cross section preview plot with relative offset set to 0.5.

NONLAYERED MATERIAL SETTINGS

In some cases, a single standard material definition is needed on the same boundary as
a layered material. This can, for example, be the case if two different physics interfaces
are active on the same boundary, but only one of them supports a layered material
definition. You can select any nonlayered material from the Material list. The default
settings is Same as layered material, which means that the nonlayered material
properties are computed as an average value of the layer’s material properties. This

selection is completely analogous to using a Material Link.

You cannot use an ordinary Material or Material Link with the same

|_i| selection as the Layered Material Link. These nodes override each other.

CHAPTER 2:

By clicking the Go to Material ( =+ ) button, you can jump to the settings for the

selected material.
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Click the Add Material from Library button (- ) to add a global material from the
material libraries or a new blank global material. The added material then becomes the

one selected in the Material list.

PREVIEW PLOT SETTINGS

In this section, you can fine-tune the display in the preview plot.

The value of the Thickness-to-width ratio controls the height in the y direction. The
width is always unity.

Deselect the Shows labels in cross-section plot check box to remove the text labels

showing layer names and materials.

MATERIAL CONTENTS

See the documentation for Material Contents for the Material node.

The Value column will usually contain the string Layer, indicating that the actual value
is layer dependent.

APPEARANCE

See the documentation for Appearance for the Material node.

Layered Material Stack

In the Layered Material Stack node (i), you can compose a new layered material by
stacking other layered materials (including Material nodes that define single-layer
materials) on top of each other. There are three main reasons why you may want to do
this:

e The layup is repetitive, say with the same four layers repeated five times. Rather than
defining twenty layers in a Layered Material node, you define four, and then add this

definition five times in a Layered Material Stack.

¢ There are layer drop-ofts, that is some layers are not present everywhere in the
structure. Then, it is efficient to create only subsets of the laminate in Layered
Material nodes, and use a number of Layered Material Stack nodes to combine them

into different configurations.

* Two Layered Material Stack nodes can have parts of their definitions linked to the
same Layered Material node. When a transition through a continuity feature is used,
the corresponding layers in two laminates defined as stacks can be connected

automatically.
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Ply modeling can be achieved from the selection of substack materials. By using
different selections on each stack member, you can create ply-based selections. From
the ply-based selections, a set of the product selections, called zone-based selections,

can be deduced and displayed in a Stack Zone Definition section (see below).

The Layered Material Stack node is located in the Layers submenu under a Materials
node. To compose the stack, you add subnodes to the Layered Material Stack. These
subnodes can be either a Layered Material or a Layered Material Link (Subnode). You
can add any number of subnodes, and mix the two types. The order of the subnodes

determines the ordering of the layers in the final laminate.

The interface between the two Layered Material Stack nodes takes the
El' interface material from the first Layered Material Stack node and ignores

the interface material of the second Layered Material Stack node.

LAYERED MATERIAL SETTINGS

From the Transform list, choose one of the following options:

* None (the default), for no transformation.

¢ Symmetric or Antisymmetric, to create a symmetric or antisymmetric layered material
when the information of layers of one side of the midplane is supplied. Choose
which side to mirror in from the Mirror in list: Upside (the default) or Downside.
Upside means that the symmetry layers are on the top of the original layers. The
symmetry line is the top-side boundary. Downside means that the symmetry layers
are on the bottom of the original layers. The symmetry line is the bottom-side
boundary. Select the Merge middle layers check box to merge the two middle layers

into one to create an odd symmetric layer.

* Repeated, to create a number of repeating stacks, which you enter in the Number of
repeats ficld (default: 1).

Select the Scale check box to scale the layered material’s thickness with a factor (default:
1). If you have defined a layer with a scaling factor, it appears in the preview window

with a darker color than a nonscaled layer.

The preview is not shown in the base geometry space, so it will not show

= any geometrical dependency.
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The labels of the newly created layers include a suffix to distinguish them from the

original layers:
* (sym) for the symmetric layers.
* (asym) for the antisymmetric layers.

e (repX) for the repeated layers (number X).

Click the Layer Cross Section Preview button (E= to plot a preview of the layer cross

section including the transformation. You can also click the downward pointing arrow
to choose Layer Cross Section Preview (== ) or Create Layer Cross Section Preview (=3),
which adds the preview plot as a new plot group under Results. Click the Layer Stack
Preview button (.. 7) to get a preview of the stack with the transformation. Click the
Create Layer Stack Plot button (@l*’) to add the preview of the layer stack as a new plot
group under Results.

A combination of transformations can be made by defining the

3 transformations for both the Layered Material Stack node and a Layered

Material Link subnode.

ORIENTATION AND POSITION

Select a Coordinate system defining the principal directions of the laminate. The
orientation of each layer, given in the Layered Material node, is a rotation from the first
coordinate axis of this coordinate system. Only Boundary System coordinate systems

can be selected.

Choose a Position — Midplane on boundary, Down side on boundary, Up side on boundary,
or User defined. This controls the possible offset of the layered material from the
geometrical boundary on which the mesh exists (the reference surface). For User
defined, enter a value for the Relative midplane offset. The value 1 corresponds to Down
side on boundary, and the value —1 corresponds to Up side on boundary. Values may be
outside the range —1 to 1, in which case the reference surface is outside the laminate.
If you use ply modeling, these additional positions are available: Midplane of stack
member on boundary, Downside of stack member on boundary, Upside of stack member
on boundary. If you choose one of those positions, also choose a member of the ply
stack from the Stack member list. Also, with one of those positions, the Automatic
alignment when the selected stack member is not available check box is selected by
default. The stack members (in zones that do not have the selected stack member) will
then be aligned with the stack members in the zone that have the selected stack

member. Clear it if you do not want that automatic alignment.
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The Position sctting is only used by physics features where the physical behavior

depends of the actual location, such as structural shells.

By clicking the Layer Cross Section Preview (=) button, you get a preview plot of the
stacked layered material, including the location of the reference surface. In

Figure 2-11, a laminate composed of three stacked layered materials, each consisting
of three layers is shown. Note that there is a slight indentation, used for emphasizing

the transition from one part of the stack to the next.
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Figure 2-11: Layer cross section preview plot with velative offset set to Down side on
boundary.

You can also click the downward pointing arrow to choose Layer Cross Section Preview
(E==2) or Create Layer Cross Section Preview (=), which adds the preview plot as a new

plot group under Results.

STACK ZONE DEFINITION
This section is available if there are multiple zones. It then lists the names of the zones,

the stack members for each zone, and the boundary selections for each zone.
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NONLAYERED MATERIAL SETTINGS

In some cases, a single standard material definition is needed on the same boundary as
a layered material. This can for example be the case if two different physics interfaces
are active on the same boundary, but only one of them supports a layered material
definition. You can select any nonlayered material from the Material list. The default
settings is Same as layered material, which means that the nonlayered material
properties are computed as an average value of the layer’s material properties. This

selection is completely analogous to using a Material Link.

- You cannot use an ordinary Material or Material Link with the same

I_il selection as the Layered Material Stack. These nodes override each other.

By clicking the Go to Material ( £+ ) button, you can jump to the settings for the

selected material.

Click the Add Material from Library button (-~ ) to add a global material from the
material libraries or a new blank global material. The added material then becomes the

one selected in the Material list.
PREVIEW PLOT SETTINGS
In this section, you can fine-tune the display in the preview plot.

The value of the Thickness-to-width ratio controls the height in the y direction. The
width is always unity.

Desclect the Shows labels in cross-section plot check box to remove the text labels
showing layer names and materials.

MATERIAL CONTENTS

See the documentation for Material Contents for the Material node.

The Value column will usually contain the string Layer, indicating that the actual value

is layer dependent.

APPEARANCE

See the documentation for Appearance for the Material node.
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Layered Material Link (Subnode)

The Layered Material Link subnode (I 1) is used for referencing a Layered Material
from a Layered Material Stack node. You can add any number of Layered Material Link

subnodes under a Layered Material Stack node.

LINK SETTINGS

Select a layered material from the Material list.

By clicking the Go to Material ( S+ ) button you can jump to the settings for the selected
material.

Click the Add Layered Material button ( - ) to add another Layered Material or a Switch.

The added material then becomes the one selected in the Material list.
From the Transform list, choose one of the following options:

¢ None (the default), for no transform.

e Symmetric or Antisymmetric, to create a symmetric or antisymmetric layered material
when the information of layers of one side of the midplane is supplied. Choose
which side to mirror in from the Mirror in list: Upside (the default) or Downside.
Upside means that the symmetry layers are on the top of the original layers. The
symmetry line is the top-side boundary. Downside means that the symmetry layers
are on the bottom of the original layers. The symmetry line is the bottom-side
boundary. Select the Merge middle layers check box to merge the two middle layers
into one to create an odd symmetric layer.

* Repeated, to create a number of repeating stacks, which you enter in the Number of

repeats ficld (default: 1).

Select the Scale check box to scale the layered material’s thickness with a factor

(default: 1). The scale can be a numerical value, a parameter, or an expression. Such an
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expression can, for example, be a function of the coordinates so that a surface with
variable thickness can be described.

If a single layer in a laminate has a variable thickness, you can define that

layer in either a separate Layered Material or in a Single Layer Material.

e When using a Layered Material, apply the scaling expression in a Layered
Material Link, and then use a Layered Material Stack to build the

i

complete laminate.

e When using a Single Layer Material with an expression for the thickness,

use a Layered Material Stack to build the complete laminate.

If you have defined a layer with a scaling factor, it appears in the preview window with
a darker color than a nonscaled layer.

. The preview is not shown in the base geometry space, so it will not show
= any geometrical dependency.

The labels of the newly created layers include a suffix to distinguish them from the
original layers:

* (sym) for the symmetric layers.
* (asym) for the antisymmetric layers.

e (repX) for the repeated layers (number X).

Click the Layer Cross Section Preview button (E= to plot a preview of the layer cross

section including the transform. You can also click the downward pointing arrow to

choose Layer Cross Section Preview (=) or Create Layer Cross Section Preview (=),

which adds the preview plot as a new plot group under Results. Click the Layer Stack
Preview button (.. 7) to get a preview of the stack with the transform. Click the Create
Layer Stack Plot button (@l*’) to add the preview of the stack with the transform as a
new plot group under Results.

Single-Layer Materials

To add a single-layer material, choose Single Layer Material ( [ ) from the global
Materials node’s context menu or the Layers submenu on the context menu of a
Materials node in a component. Then, a Material node is created with some additional

settings (see The Settings Window for Material) and a Shell property group (see
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Geometric Properties (Shell)) with a default thickness of 10~* m. You can also switch
an Material node into a single-layer material by adding a Shell property group and
define a thickness, and it can also turn into a single-layer material when you specify a
value for the requested thickness in the Material Contents table, which appears when a
layered shell feature requests the material properties from a standard material. The
thickness for a single-layer material can be defined as a numerical value, a parameter,
or an expression. Such an expression can, for example, be a function of the coordinates

so that a surface with variable thickness can be described.

If a single layer in a laminate has a variable thickness, you can define that

layer in either a separate Layered Material or in a Single Layer Material.

* When using a Layered Material, apply the scaling expression in a Layered
Material Link, and then use a Layered Material Stack to build the

[

complete laminate.

* When using a Single Layer Material with an expression for the thickness,

use a Layered Material Stack to build the complete laminate.

CHAPTER 2:

Single-layer materials provide a quick way to define data for a nonlayered material to
be used in physics feature designed for layered materials. Using a single-layer material
is equivalent to defining a Layered Material with only one layer and then referencing it
through a Layered Material Link. A single-layer material can be linked by a Layered

Material Link, and it can also e a stack member of a Layered Material Stack or a switch

member of a Switch for Materials.

Porous Material

Add a Porous Material node (:im ) under a Materials node in a model component to add
a definition of a porous material. In the settings for this node you can define the

porosity of the porous material, or you can right-click the Porous Material node to add
Fluid, Solid, Pellet, and Immobile Fluid subnodes as required and define the porous

material properties in those subnodes.

POROSITY

If you have not added any subnode for defining the porous material, enter a value or
expression between 0 and 1 in the g, field. Otherwise, depending on the added
subnodes, the corresponding expression for the porosity of the porous material appears

here under Volume fractions of immobile phases.
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PHASE-SPECIFIC PROPERTIES

Physics features that support porous media request properties per phase present. These
properties are listed in the Phase-Specific Properties table. All phase-specific properties
need to be specified in a corresponding subnode to the Porous Material node (as a Solid,
Liquid, or Pellet subnode). The list can contain multiple entries of the same kind, such
as the density of the fluid and the density of the solid. When a subnode is missing, a

red stop symbol appears in the table, and the Add Required Phase Nodes button (=37 )
is active. Click that button to create the missing subnodes. You then need to go to the

created subnodes and define all requested properties there.

Right-click a row in the Property and Phase columns to choose Go to Requesting Node
to move to the physics node that requested the property, or choose Go to Source to

move to the subnode that is the source for the property, when applicable.

Click any column header to sort the list alphabetically according to the content in that

column. You can use this to, for example, list the properties according to their phase.

HOMOGENIZED MATERIAL

From the Material list, choose the material to represent the homogenized material:
Locally defined (the default), or select any other material that you have added. Click the
Go to Material button ( S ) to move to the selected material’s node. Click the Add
Material from Library button (-} to add a material from the Add Material to Pellet
window. You can also click the downward arrow next to the button and choose Blank
Material to add a new blank material. In both cases, the added material becomes

selected in the Material list.

HOMOGENIZED PROPERTIES

When physics features that do not support porous media take properties From material,
and the domain material is a porous material, then properties are shown in the
Homogenized Properties table. Here, there is only one set of properties and not one per
phase. The properties are to be thought of as homogenized in some manner. The
material is porous, but for the one-phase interface, homogenized properties are used.
In this manner you can, for example, add a Solid Mechanics interface to a model of
porous media and model the structural mechanics part as usual. When the Material in
the Homogenized Material scction is Locally defined, enter values or expressions for the

properties in the Value column.

APPEARANCE

For the Appearance settings, see Appearance.
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Fluid

Right-click a Porous Material node to add a Fluid subnode (:i=: ) to define properties of
a fluid phase in the porous medium.

FLUID PROPERTIES

From the Material list, choose the material to represent the fluid: Locally defined (the
default), or select any other material that you have added. Click the Go to Material
button ( E':l ) to move to the selected material’s node. Click the Add Material from
Library button (- to add a material from the Add Material to Pellet window. You can
also click the downward arrow next to the button and choose Blank Material to add a
new blank material. In both cases, the added material becomes selected in the Material
list.

MATERIAL PROPERTIES

This section is only available if you have selected Locally defined from the Material list
in the Fluid Properties section. You can then choose material properties that you want
to add for the fluid from the list and then click the Add to Material button (-} ) to add

those properties to the table in the Material Contents section below.

MATERIAL CONTENTS

This section contains a table with the material properties for the fluid, which typically
consist of the porosity and the material properties from the chosen material for the
fluid. When the Material in the Fluid Properties section is Locally defined, enter values or
expressions for the properties in the Value column. You can also click the Edit button

(7#") below the table to enter the property values.

Solid

Right-click a Porous Material node to add a Selid subnode (:im) to define properties of

a solid phase in the porous medium.

SOLID PROPERTIES

From the Material list, choose the material to represent the solid: Locally defined (the
default), or select any other material that you have added. Click the Go to Material
button ( E4 ) to move to the selected material’s node. Click the Add Material from
Library button (- to add a material from the Add Material to Pellet window. You can
also click the downward arrow next to the button and choose Blank Material to add a
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new blank material. In both cases, the added material becomes selected in the Material
list.

For the Volume fraction of the solid, enter a value between 0 and 1 in the 65 field.

MATERIAL PROPERTIES

This section is only available if you have selected Locally defined from the Material list
in the Solid Properties section. You can then choose material properties that you want
to add for the solid from the list and then click the Add to Material button ( -}- ) to add

those properties to the table in the Material Contents section below.

MATERIAL CONTENTS

This section contains a table with the material properties for the solid, which typically
consist of the porosity and the material properties from the chosen material for the
solid. When the Material in the Solid Properties section is Locally defined, enter values
or expressions for the properties in the Value column. You can also click the Edit button
(7#") below the table to enter the property values.

Pellet

Right-click a Porous Material node to add a Pellet subnode (::% ) to define properties
of a pellet phase in the porous medium.. The Pellet subnode provides the properties
for a certain type of pellets that the solid part of the porous material consists of. A
porous material can include pellets of different types. For example, the pellets might
be a mix of 30% spherical pellets with a certain diameter, 20% spherical pellets with
another diameter, and 50% of a third type of pellet that is cylindrical instead of
spherical. Those 100% together form the solid phase in the “pellet bed”.

A Pellet node provides the geometrical properties for pellets and material properties for
the solid phase in the pellet, such as density and heat capacity. The material properties
for the fluid phase should be defined in a Fluid subnode.

When a Porous Material node is used in the physics, then all pellet types will exist at
each point in the geometry. Therefore, the plural form, Pellets as a subnode to the
Packed Bed node, used in the Chemical Reaction Engineering Module to model packed
bed reactors with catalytic pellets. Also, Pellets as a subnode to the Porous Medium node
can be used to model the local temperature field within pellets when using a Heat

Transfer in Porous Media interface.
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PELLET PROPERTIES

From the Material list, choose the material to represent the pellet: Locally defined (the
default), or select any other material that you have added. Click the Go to Material
button ( £+ ) to move to the selected material’s node. Click the Add Material from
Library button (- to add a material from the Add Material to Pellet window. You can
also click the downward arrow next to the button and choose Blank Material to add a
new blank material. In both cases, the added material becomes selected in the Material
list.

From the Shape list, define the shape of the pellet: Sphere (the default), Cylinder, Flake,
or User defined. For Sphere and Cylinder, further specify a Diameter d, (SI unit: m),
where the default value is 1 mm. For Flake, define a Thickness d, (SI unit: m) in a
similar way. For User defined, specify the Pellet surface A, (SI unit: m?> ) and Pellet
volume V. (SI unit: ms)

Also specify a Porosity €, as a relative number between 0 and 1 (default: 0.1). This is

the microscale porosity of the inside of an individual pellet.

If you define a second Pellet subnode, the Pellet Bed Properties scction below is not
available. Instead, specify a Bed volume fraction, a relative number between 0 and 1.
Only the first Pellet subnode can define the pellet bed porosity. For additional Pellet

subnodes, you instead specify the volume fraction relative to the other pellet types.

PELLET BED PROPERTIES

In this section you specify the porosity of the pellet bed. From the Porosity list, choose
User defined (the default) or From densities. With User defined, add a value for the
porosity & as a relative number between 0 and 1 (default: 0.26, representing perfectly
packed spheres). With From densities, the porosity is defined as 1 — py,/pp,e, where you
define the density of the packed bed, py, in the Density field (default: 800 kg/ms).

MESH

In this section you specify the properties of the mesh for the extra dimension that each
Pellet subnode defines so that both the species concentration and the temperature can
be computed locally in the pellet.

For the mesh distribution, choose Linear, Cubic root sequence (the default), or Square
root sequence from the Distribution list. Also, specify the Number of elements
(default: 6).
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Click the Extra Dimension Mesh Preview button ({} ) in the Mesh section toolbar to get
a plot of the extra dimension mesh in a separate plot window, showing the mesh

distribution and direction.

MATERIAL PROPERTIES

This section is only available if you have selected Locally defined from the Material list
in the Pellet Properties section. You can then choose material properties that you want
to add for the pellet from the list and then click the Add to Material button (- ) to

add those properties to the table in the Material Contents section below.

MATERIAL CONTENTS

The table in this section contains the material properties for the pellet material. When
the Material in the Pellet Properties section is Locally defined, enter values or expressions
for the properties in the Value column. You can also click the Edit button (@ ) below
the table to enter the property values.

Immobile Fluid

Right-click a Porous Material node to add a Immobile Fluid subnode (::=) to define

properties of an immobile fluid phase in the porous medium..

IMMOBILE FLUID PROPERTIES
From the Material list, choose the material to represent the immobile fluid: Locally

defined (the default), or select any other material that you have added. Click the Go to

Material button ( Z¢ ) to move to the selected material’s node. Click the Add Material
from Library button (- to add a material from the Add Material to Pellet window. You
can also click the downward arrow next to the button and choose Blank Material to add
anew blank material. In both cases, the added material becomes selected in the Material
list.

For the immobile fluid’s Volume fraction, enter a value between 0 and 1 in the 6;,¢

field.

MATERIAL PROPERTIES

This section is only available if you have selected Locally defined from the Material list
in the Immobile Fluid Properties section. You can then choose material properties that
you want to add for the immobile fluid from the list and then click the Add to Material
button (-} ) to add those properties to the table in the Material Contents section

below.
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MATERIAL CONTENTS

This section contains a table with the material properties for the immobile fluid, which
typically consist of the porosity and the material properties from the chosen material
for the immobile fluid. When the Material in the Immobile Fluid Properties section is
Locally defined, enter values or expressions for the properties in the Value column. You
can also click the Edit button (#") below the table to enter the property values.

Topology Link

Add a Topology Link node ( 2:2 ) under a Materials node in a model component to add
material based on a material that you have added under the global Materials node ( (=iz)
and Density Model use( {7 ;) that you have added under the component Definitions node

( = ). To add it, right-click the Materials node and choose Topology Link from the More
Materials submenu.

The Topology Link will be added automatically, if one of the topology optimization

study steps is chosen in the model wizard.

LINK SETTINGS

From the Material list, select the global material that you want to link to:

e Any global material node, to use that material in the component.

* Any Switch node, if you want to run a material sweep.

¢ None, to not link to any global material.

From the Topology source list, sclect the Density Model, which should modify the
material. The Density model will scale the Young’s modulus with the penalized

material volume factor (dtopo#.theta_p), and the density with the output material
volume factor (dtopo#.theta).
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Material Properties

The materials included in the Material Library are defined by unique material
properties, each available as a function of temperature or another appropriate

argument. Table 2-4 lists most of the material properties in the Material Library.

It is important to check the validity of the material property function
n under the conditions that you are interested in investigating. See

Checking the Validity of Properties in the Material Library.

Individual material properties contained in the Material Library are based
on the Material Property Database (MPDB) from JAHM Software, Inc.

i

Viewing Material Property Information

For all properties contained in the Material Library, you can view applicable literature
references, notes, and reference temperatures in the Material Browser’s Property
reference section.

I Open the Material Browser.

2 Under Material Library, click to select a material. For example, Nitrogen. The

information about this material displays on the right-hand side of the window.

3 Under Properties in the table, click a Property to sce its references in the Property

reference section. See Figure 2-12.
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Properties

Property Expression Unit Prop

dL (dLiT[L/K])-dLiTempre

CTE CTE(T[1/KI[1/K]

Thermal conductivity k_liquid_2(TILARDMW (n ) W (™K
Coefficient of thermal expan: | (alpha(T[1/K])[1/K]+(Te 1/K
|Densit_~,r |rh|:u_|i|:|uid_1f|'[l.fK]][kg. kg/m*"3

VP WP liguid 2(T[1/KTI[Pa]
Property reference:

Density

Reference: RLB. Scott, Cryogenic Engineering, Pub. D, van Mostrand Cot
(1962)
Mote: saturated liguid; interpelated between 63.1K and 64.8K

I

T e i

Figure 2-12: An example of where you can find the property veference information for a
material. In this example, Density has this information available in the Property refevence
section. You can hover over the section and drayg to expand it if required.

Functions Defanlt Values in the Material Library

The material property expressions stored in the Material Library contain calls to the
corresponding material property functions using input variables (arguments) as in
Table 2-3. The default variable name can be changed in the property expressions to
match actual variable names in a model. When a material property is used by a physics
feature set to retrieve the property From material this is not necessary. In that case, the
actual variable are retrieved from the Model Inputs section of the same feature and

automatically substituted into the material property expression.

If you, on the other hand, want to access material properties from a material explicitly,
you need to make sure that the function argument variables used in the property

expressions exist and can be evaluated in the model. For example, if the variable T2 is
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used for temperature, change the argument of the property functions from T to T2 in

the expressions.

The argument does not have to be a variable defined by the model (such

as dependent variables) — it can also be a user-defined constant or

i

variable. In general, COMSOL Multiphysics tries to find the best match

for evaluating function arguments when material properties are accessed

explicitly.

TABLE 2-3: DEFAULT FUNCTION ARGUMENTS IN MATERIAL PROPERTY EXPRESSIONS

ARGUMENT DEFAULT VARIABLE UNIT
Temperature T K
Time t h
Effective plastic strain epe -
Number of cycles n -
Norm of H field normH_emnc Alm
Norm of B field normB_emqga T

Available Material Library Material Properties

The following table lists the material properties in the Material Library:

TABLE 2-4: MATERIAL LIBRARY: AVAILABLE MATERIAL PROPERTIES

PROPERTY SHORT NAME  ARGUMENT SIUNIT
Coefficient of thermal expansion alpha Temperature 1/K
Creep strength CS Time Pa
Density rho Temperature kg/m3
Dynamic viscosity eta Temperature Pa:s
Electrical conductivity sigma Temperature S/m
Resistivity res Temperature ohm'm
Elongation elong Temperature -
Fatigue E-N curve FEN Number of cycles Pa
Fatigue S-N curve FSN Number of cycles Pa
Heat capacity C Temperature J/(kg-K)
Bulk modulus K Temperature Pa
Shear modulus G Temperature Pa
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TABLE 2-4: MATERIAL LIBRARY: AVAILABLE MATERIAL PROPERTIES

PROPERTY SHORT NAME  ARGUMENT SIUNIT
Instantaneous coefficient of thermal CTE Temperature I/K
expansion

Linear expansion dL Temperature -
Molar heat capacity HC Temperature J/(mol-K)
Nonlinear magnetic flux density, norm  normB Norm of H field T
Nonlinear magnetic field, norm normH Norm of B field A/m
Normal total emissivity nemiss Temperature -
Poisson’s ratio nu Temperature -
Relative permeability mur Norm of H field -
Stress rupture SR Time Pa
Surface emissivity epsilon Temperature -
Tensile strength Syt Temperature Pa
Thermal conductivity k Temperature W/(m-K)
Thermal diffusivity TD Temperature m?/s
True stress—true strain curve in tension  Syfunc Strain Pa
True stress—true strain curve in Syfunccomp  Strain Pa
compression

Vapor pressure VP Temperature Pa
Yield strength level Sys Temperature Pa
Young’s modulus E Temperature Pa

Checking the Validity of Properties in the Material Library

The following section lists points to consider about the definition, error estimate, and

conditions for some of the Material Library properties listed in Table 2-4.

The property functions listed below have a literature reference where you
can find more details about the conditions and validity range for that

specific property.
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COEFFICIENT OF THERMAL EXPANSION

The coefficient is defined as (AL/L)p/(T — T'.of) and in most cases, it is calculated
from the AL/L values.

The error is expected to be in the range of 10-15%, but it might be higher near

room temperature due to the small value of T'— T'pef.

ELASTIC AND INITIAL SHEAR MODULUS

The data accuracy is approximately 5-10%.

For solder alloys the literature reports a wide spread of values. Data from several
sources (when available) are evaluated, and representative values are given; the error
is estimated to be 10-25%.

For some polymers the flexural modulus is used as the elastic modulus, and it is
typically within 10% of the elastic modulus.

Typically, values measured with a strain gauge are approximately 10% lower than
those measured with a dynamic technique.

Values measured by a dynamic technique are preferred over those measured by

strain gauge techniques.

For cubic materials where the elastic and shear modulus are calculated from the
elastic constants (C11, C12, and C44), the Material Library uses the average of the
Reuss and Voigt equations (see R.E.S. Hearmon, Advances in Physics,vol. 5,1956,
p. 232).

For isotropic solids (glasses), it uses methods from L.D. Landau and E.M. Lifshitz,
Theory of Elasticity, Addison-Wesley, New York, 1966.

POISSON'S RATIO AND INITIAL BULK MODULUS

Calculated from the elastic modulus and the shear modulus using standard

relationships, and in this sense they are self-consistent and accurate.

Data accuracy is approximately 10-20%. Because these are derived quantities the

error can be significantly higher.

The curves for these properties often show improbable shapes that are most likely
due to their derived nature and are not believed to be real. If the elastic and shear
modulus were determined in a self-consistent manner, the curves would likely be
much better behaved. However, all of the data are presented “as is” from the
original references and are self-consistent within the Material Library.
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THERMAL CONDUCTIVITY
* Can be very sensitive to impurities, heat treatment, and mechanical worked state,

especially at very low temperatures.

* The sensitivity is somewhat decreased above room temperature and decreases as the
amount of alloying increases. Compare 4340-QT (quenched and tempered) and
4340-NT (annealed).

THERMAL DIFFUSIVITY
» For metals this property can be very sensitive to impurities, heat treatment, and

mechanical worked state, especially at very low temperatures.

 This sensitivity is somewhat decreased above room temperature and decreases as the
amount of alloying increases. To see an example of this, compare the data for

elemental (high purity) Fe and Armco iron (commercial purity).

ELECTRIC RESISTIVITY
This property is very sensitive to impurities, heat treatment, and mechanical worked

state, especially at very low temperatures.

ELECTRICAL CONDUCTIVITY
This property is very sensitive to impurities, heat treatment, and mechanical worked

state, especially at very low temperatures.

SURFACE EMISSIVITY (&p)
This property is the measured emissivity over all wavelengths and 2r radians. This is

the emissivity used in the Stefan-Boltzmann law.

NORMAL TOTAL EMISSIVITY (ery)
* The measured emissivity is over all wavelengths at a direction normal to the surface.

This is the most commonly reported value.
* For polished metal, this assumption is valid: ey/ey , = 1.15-1.20.

¢ Both emissivities are sensitive to the surface condition (roughness and oxide
thickness).

DENSITY (p)
¢ The density for solids is calculated from the room-temperature density and the
linear expansion coefficient and is given by p/(1 + AL/L)3.

¢ The data for oxides, carbides, and nitrides depend on the material’s porosity.

* For gases the ideal gas law is used.
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TENSILE STRENGTH, YIELD STRENGTH LEVEL, AND ELONGATION

Most of the data for tensile strength, yield strength level, and elongation

is from supplier product brochures. When using this data, remember it is

m

only representative of the actual material properties.

e The variation with temperature is usually not smooth. Many of these materials are
precipitation hardening alloys, and the temperature affects the aging processes in
different ways at different temperatures.

e Unless otherwise stated, the data are for “short” times at the indicated temperatures
and not for the equilibrium structure.

* These properties are very sensitive to the details of the processing and heat
treatments. Comparison of data from different suppliers indicate that the spread in
the published values is approximately 20% for materials with similar processing. The
spread in the elongation data can be as high as 50-100%.

FATIGUE S-N CURVE

 Fatigue data is given as the maximum stress, Gy, 5, as function of the number of
cycles. The stress amplitude, maximum stress, and minimum stress are related
through the stress ratio, R.

(O max — Omin)
o — max min R — max

a 2 c

e The maximum stress, Oy, is given together with the stress ratio for all fatigue data.
Then calculate the stress amplitude as:

CREEP STRENGTH AND STRESS-RUPTURE CURVES

This property is very sensitive to the test atmosphere as well as the microstructure and
heat treatment of the material.

POLYMERS AND POLYMER-BASED COMPOSITES

Properties of polymers and polymer-based composites are sensitive to moisture and
processing conditions, and they can show time-dependence at higher temperatures.
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The errors/uncertainties can be large compared to those of other materials. Keep these

aspects in mind when using the properties of these materials.

GENERAL
The magnitude of the errors reported by authors for a given property is usually smaller
by a factor of 2—-3 than the error between different sources for the same data. This is

especially true for materials such as ceramics.
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Other Material Properties Reference

In addition to the specific properties included with the Material Library, the other
material databases also contain predefined variables for various material properties that

can be used when creating a model.

The material properties for the predefined materials are accessible from most physics
interfaces. Using this information, either create a material property group or define a

completely new material.

In the Basic>Property Group window, you can add Output Properties under the
Quantities subsection. You can also add Model Inputs to, for example, create a

temperature-dependent material property.

About Model Inputs

Model inputs is a special type of parameter in physics features or physics properties
where you can choose from a list of announced variables (typically field quantities such
as temperature, concentration, or electric field, where vector fields have three
components). Model inputs can also be used as an input to a Property Group under a
material to represent, for example, a temperature-dependent material property. If the
property group specifies that it supports one or more model inputs, any physics feature
that uses the group’s material will display those model input lists in the Model Inputs
section of the physics node’s Settings window. Any physical quantity in COMSOL
Multiphysics can be used as a model input.

Model inputs are always available as default model inputs. See Default Model Inputs
in the COMSOL Multiphysics Refevence Manual.
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All physical quantities that can act as model inputs declare and define common

variables that are always available (for example, minput.T for the temperature T').

To define the absolute pressure for heat transfer, see the settings for the
Fluid node in the COMSOL Multiphysics Reference Manual.

To define the absolute pressure for a Fluid Flow interface, see the settings
for the Fluid Properties node (described for the Laminar Flow interface
in the COMSOL Multiphysics Reference Manual).

[

If you have a license for a Nonisothermal Flow interface, see that

documentation for further information.

Model Inputs and Multiphysics Couplings in the COMSOL Multiphysics
@ Reference Manual

About the Output Material Properties

Some of these material groups are only used by physics interfaces in the
|'i-|' add-on modules and detailed information is in the applicable

documentation.

This section describes all available property groups and the material properties that
they contain. These material properties can be added to models from two Settings

windows: the Material node’s window and its subnodes’ Property Group windows.

The Basic group contains over 25 basic properties for use with all materials.

{i Materials in the COMSOL Multiphysics Reference Manual
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BASIC MATERIAL PROPERTIES

These common material properties belong to the Basic property group.

¢ When this information is accessed from the Basic>Property Group window, it is listed

under Quantities>Output Properties and Variable is listed in the table.

¢ When this information is accessed from the Material window, it is listed under

Material Properties>Basic Properties and Name is listed in the table under

Material Contents.

TABLE 2-5: BASIC MATERIAL PROPERTIES

PROPERTY NAME/VARIABLE SIUNIT
Absorption Coefficient kappaR I/m
Activation Energy dE J/mol
Bulk Viscosity muB Pa‘s
Characteristic Acoustic Impedance z Pa-s/m
Coefficient of Hygroscopic Swelling beta_h_iso, beta_hii m3/kg
Coefficient of Thermal Expansion alpha I/K
Compressibility of Fluid chif I/Pa
Density rho kg/m3
Diffusion Coefficient D m?/s
Dynamic Viscosity mu Pa's
Electrical Conductivity sigma S/m
Electron Mobility mue mZ/(Vs)
Extinction Coefficient betaR I/m
Frequency Factor A I/s
Heat Capacity at Constant Pressure Cp JI(kg:K)
Isotropic Structural Loss Factor etas |

Mass Flux Mf kg/(m2-s)
Mean Molar Mass Mn kg/mol
Permeability kappa m?
Poisson’s Ratio nu I
Porosity epsilon |

Ratio of Specific Heats gamma |
Relative Permeability mur 1
Relative Permittivity epsilonr 1
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TABLE 2-5: BASIC MATERIAL PROPERTIES

PROPERTY NAME/VARIABLE SIUNIT
Resistivity res Q:m
Scattering Coefficient sigma$S I/m
Seebeck Coefficient S VIK
Shifted Magnetic Field shiftedH A/m
Speed of Sound cp m/s
Storage S 1/Pa
Surface Emissivity epsilon rad |
Thermal Conductivity k W/(m-K)
Thermal Conductivity Supplement b |
Vapor Permeability delta_p s
Vapor Resistance Factor mu_vrf |
Water Content w_c kg/m3
Young’s Modulus E Pa

The coefficient of thermal expansion (CTE) and the resistivity

temperature coefficient have the SI unit 1 /K. COMSOL Multiphysics
translates this into the Fahrenheit temperature unit using an offset. This

g translation means that you do not get the expected results.

Use caution when a model uses the coefficient of thermal expansion or the
resistivity temperature coefficient and the unit system’s temperature is not

kelvin.
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The rest of the material properties are grouped by application area:

* Acoustics Material Properties

¢ Electrochemistry Material

Properties
e Electromagnetic Models
* Equilibrium Discharge

e Gas Models

e Geometric Properties (Shell)

* Magnetostrictive Models

e DPiczoelectric Models

e DPiezoresistive Models

* Semiconductors Material Properties

* Solid Mechanics Material Properties

* Solid Mechanics Material Properties:

Nonlinear Structural Materials

Module

* Solid Mechanics Material Properties:

Fatigue Module

* Solid Mechanics Material Properties:

Geomechanics Material Model

Acoustics Material Properties

Under Acoustics, you find the following acoustic material models with their associated

material properties: a Poroacoustics Model, a Thermoviscous Acoustics Model, and a

Viscous Model.

These material property groups (including their associated physical properties) can be

added to models from the Material window. These property groups are used by the

Acoustics Module.

TABLE 2-6: ACOUSTICS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT
NONLINEAR MODEL

Parameter of nonlinearity BA |
POROACOUSTICS MODEL

Flow resistivity Rf Pa-s/m?
Thermal characteristic length Lth m
Viscous characteristic length Lv m
Tortuosity factor tau I
THERMOVISCOUS ACOUSTICS MODEL

Bulk viscosity muB Pa‘s
Density rho kg/m3
Dynamic viscosity mu Pa‘s
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TABLE 2-6: ACOUSTICS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT
Heat capacity at constant pressure  Cp JI(kg'K)
Thermal conductivity k W/(m-K)
VISCOUS MODEL

Bulk viscosity muB Pa‘s

Electrochemistry Material Properties

These material property groups for electrochemistry (including their associated

physical properties) can be added to models from the Material window. These property
groups are used by the Battery Design Module, Corrosion Module, Electrochemistry
Module, Electrodeposition Module, and Fuel Cell & Electrolyzer Module.

TABLE 2-7: ELECTROCHEMISTRY MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT
EQUILIBRIUM POTENTIAL

Equilibrium potential Eeq \
Reference concentration cEeqref mol/m?3
Temperature derivative of dEeqdT VIK
equilibrium potential

ELECTROLYTE CONDUCTIVITY

Electrolyte conductivity sigmal S/m
ELECTROLYTE SALT CONCENTRATION

Electrolyte salt concentration cElsalt mol/m?3

LINEARIZED RESISTIVITY

Reference resistivity
Reference temperature

Resistivity temperature coefficient

OPERATIONAL ELECTRODE
STATE-OF-CHARGE

Maximum electrode
state-of-charge

Minimum electrode
state-of-charge

This material node defines the electric resistivity
(and conductivity) as a linear function of
temperature.

rho0 Q'm
Tref K
alpha I/K
socmax |
socmin |
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TABLE 2-7: ELECTROCHEMISTRY MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT
SPECIES PROPERTIES
Transport number transNum

Electromagnetic Models

These material property groups for various electromagnetic material models (including
their associated physical properties) can be added to models from the Material window.
These property groups are used by the AC/DC Module, RF Module, and Wave Optics
Module.

TABLE 2-8: ELECTROMAGNETIC MODELS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT

B-H CURVE

Local Properties

Magnetic flux density norm
DIELECTRIC LOSSES

Dielectric loss factor

Relative permittivity (imaginary part)
Relative permittivity (real part)

E-) CHARACTERISTIC

Electric field norm

Local Properties

EFFECTIVE B-H CURVE

Local Properties

Magnetic flux density norm

EFFECTIVE H-B CURVE
Local Properties
Magnetic field norm

H-B CURVE

Local Properties

This material node is only available with the
AC/DC Module.

normH -
normB T
eta_epsilon -
epsilonBis 1
epsilonPrim 1

This material node is only available with the
AC/DC Module.

normE V/M
norm) -

This material node is only available with the
AC/DC Module.

normHeff -
normBeff T

This material node is only available with the
AC/DC Module.

normBeff -
normHeff A/m

This material node is only available with the
AC/DC Module.

normB -
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TABLE 2-8: ELECTROMAGNETIC MODELS MATERIALS

PROPERTY GROUP AND PROPERTY

NAME/VARIABLE SI UNIT

Magnetic field norm

JILES-ATHERTON MODEL PARAMETERS

Maximum magnetization parameter
Langevin slope parameter

Pinning parameter

Reversibility parameter

Interdomain coupling parameter

LINEARIZED RESISTIVITY

Reference resistivity
Reference temperature

Resistivity temperature coefficient

LOSS TANGENT, LOSS ANGLE

Loss tangent, loss angle

Relative permittivity (real part)

LOSS TANGENT, DISSIPATION FACTOR

Loss tangent, dissipation factor
Relative permittivity (real part)
MAGNETIC LOSSES

Relative permeability (imaginary part)
Relative permeability (real part)

REFRACTIVE INDEX

Refractive index, imaginary part

Refractive index

REMANENT FLUX DENSITY

normH A/m

This material node is only available with the

AC/DC Module.

MsJA (3x3 matrix) A/m
aJA (3x3 matrix) A/m
kJA (3x3 matrix) A/m
cJA (3x3 matrix) |
alphaJA (3x3 matrix) |

This material node defines the electric
resistivity (and conductivity) as a linear
function of temperature.

rho0 Q'm
Tref K
alpha I/K

This material node assumes zero
conductivity.

delta rad
epsilonPrim |

This material node assumes zero
conductivity.

tanDelta |

epsilonPrim |

murBis -
murPrim -

This material node assumes a relative

permeability of unity and zero conductivity.
This material node is only available with the

RF Module or the Wave Optics Module.
ki -

n |

This material node is only available with the

AC/DC Module.
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TABLE 2-8: ELECTROMAGNETIC MODELS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT
Recoil permeability murec I
Remanent flux density norm normBr T

Equilibrium Discharge

These material property groups for all the material models in the Equilibrium
Discharge (including their associated physical properties) can be added to models from
the Material window. These property groups are used by the Plasma Module.

TABLE 2-9: EQUILIBRIUM DISCHARGE MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT
RADIATION HEAT TRANSFER

Total volumetric emission Qrad W/m3
coefficient

Gas Models

This material property group for an ideal gas (including its associated physical
properties) can be added to models from the Material page.

TABLE 2-10: GAS MODELS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT
IDEAL GAS

Heat capacity at constant pressure Cp JI(kg'K)
Mean molar mass Mn kg/mol
Ratio of specific heats gamma I
Specific gas constant Rs JI(kg'K)

Geometric Properties (Shell)

The Shell material property group is used in connection with layered materials (it is, for
example, added when you add a Material node by choosing Single Layer Material

from the Layers submenu on the Materials node’s context menu. This property group
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contains geometric properties for the definition of a layer in the Layer Definition

section.

TABLE 2-11: SHELL PROPERTIES

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT
SHELL

Thickness Ith m
Rotation Irot rad/mol
Mesh elements Ine |

Magnetostrictive Models

These material property groups for various magnetostrictive material models
(including their associated physical properties) can be added to models from the
Material window. These property groups are used by the AC/DC Module.

TABLE 2-12: MAGNETOSTRICTIVE MODELS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT
MAGNETOSTRICTIVE

Saturation magnetization Ms A/m
Initial magnetic susceptibility chi |
Saturation magnetostriction lambdas |
Magnetostriction constants lambda 100 |
Magnetostriction constants lambdal I | |

STRAIN-MAGNETIZATION FORM

Compliance matrix
Loss factor for compliance matrix sH
Piezomagnetic coupling matrix

Relative permeability

STRESS-MAGNETIZATION FORM

Elasticity matrix
Loss factor for elasticity matrix cH
Piezomagnetic coupling matrix

Relative permeability

This material node is only available with the
AC/DC Module.

sH (6x6 matrix) I/Pa
eta_sH (6x6 matrix) |
dHT (3x6 matrix) m/A

murT (3x3 matrix) |

This material node is only available with the
AC/DC Module.

cH (6x6 matrix) Pa
eta_cH (6x6 matrix) |
eHS (3x6 matrix) T

murS (3x3 matrix) |
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Piezoelectric Models

These material property groups for piezoelectric materials (including their associated

physical properties) can be added to models from the Material window. These property

groups are used by the Acoustics Module, MEMS Module, or Structural Mechanics

Module.

TABLE 2-13: PIEZOELECTRIC MATERIALS

PROPERTY GROUP AND PROPERTY  NAME/VARIABLE SIUNIT
STRAIN-CHARGE FORM

Compliance matrix sE 1/Pa
Coupling matrix dET C/N
Loss factor for compliance sE |
matrix

Loss factor for coupling matrix  d |
Loss factor for electrical eT |
permittivity

Relative permittivity epsilonrT |
STRESS-CHARGE FORM

Coupling matrix eES Cim?
Elasticity matrix cE Pa
Loss factor for elasticity matrix cE |
Loss factor for coupling matrix e |
Loss factor for electrical N |
permittivity

Relative permittivity epsilonrS |

Piezoresistive Models

These material property groups for piezoresistive materials (including their associated

physical properties) can be added to models from the Material window. These property
groups are used by the MEMS Module.

TABLE 2-14: GAS MODELS MATERIALS

PROPERTY GROUP AND PROPERTY

NAME/VARIABLE SI UNIT

ELASTORESISTANCE FORM

Elastoresistive coupling matrix

ml

Q'm
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TABLE 2-14: GAS MODELS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT

PIEZORESISTANCE FORM

Piezoresistive coupling matrix Pil Alm?

Semiconductors Material Properties

These material property groups for all the material models in semiconductors
(including their associated physical properties) can be added to models from the

Material window. These property groups are used by the Semiconductor Module.

The Property Group, Variable Names, and SI Unit columns are applicable
to all materials in the Semiconductor Module. However, the Values and

[

References columns listed in Table 2-15 are specifically for silicon in the
COMSOL Multiphysics Reference Manual.

TABLE 2-15: SEMICONDUCTOR MATERIAL PROPERTIES (ALL MATERIALS) AND VALUES AND REFERENCES FOR
SILICON

PROPERTY GROUP AND  NAME/VARIABLE (ALL  SIUNIT VALUE FOR REFERENCE
PROPERTY (ALL MATERIALS) SILICON FOR
MATERIALS) SILICON
BASIC

Relative permittivity  epsilonr | 1.7 Ref. 1
Thermal k WI(mK) 131 W/(m'K) Ref 1
conductivity

Density rho kg/m> 2329 kgm>  Ref 1
Heat capacity at Cp J/(kg'K) 700 J/(kg'K) Ref. 1

constant pressure
BAND-GAP NARROWING MODELS>JAIN-ROULSTON MODEL

Jain-Roulston An_jr \ 35108 v Ref. 12
coefficient (n-type),
A

Jain-Roulston Bn_jr \ ov Ref. 12
coefficient (n-type),
B

Jain-Roulston Cn_jr \ ov Ref. 12
coefficient (n-type),
C
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TABLE 2-15: SEMICONDUCTOR MATERIAL PROPERTIES (ALL MATERIALS) AND VALUES AND REFERENCES FOR

SILICON
PROPERTY GROUP AND  NAME/VARIABLE (ALL  SIUNIT VALUE FOR REFERENCE
PROPERTY (ALL MATERIALS) SILICON FOR
MATERIALS) SILICON
Jain-Roulston Ap_jr \ 35108V Ref. 12
coefficient (p-type),

A

Jain-Roulston Bp_jr A% ov Ref. 12
coefficient (p-type),

Jain-Roulston Cp_jr \ ov Ref. 12
coefficient (p-type),

C

Band-gap narrowing  Nref_jr I/m3 | l/em® Ref. 12
reference

concentration

Conduction band alpha_jr 0.5 Ref. 12
fraction

BAND-GAP NARROWING MODELS>SLOTBOOM MODEL

Band-gap narrowing  Eref_sb Vv 0.00692 V Ref. 11
reference energy

Band-gap narrowing  Nref_sb I/m3 13:10'7 1/ Ref 11
reference cm

concentration

Conduction band alpha_sb 0.5 Ref. 11
fraction

GENERATION-RECOMBINATION>AUGER RECOMBINATION

Auger Cn m®/s 28103 em®  Ref. 2

recombination
factor, electrons

Auger Cp m
recombination
factor, holes

S

GENERATION-RECOMBINATION>DIRECT RECOMBINATION

Direct C m3/s
recombination factor

Is

(valid at

300 K)

991032 em®  Ref. 2
Is

(valid

at 300 K)

0mds N/A

OTHER MATERIAL PROPERTIES REFERENCE

83



TABLE 2-15: SEMICONDUCTOR MATERIAL PROPERTIES (ALL MATERIALS) AND VALUES AND REFERENCES FOR

SILICON

PROPERTY GROUP AND  NAME/VARIABLE (ALL  SIUNIT VALUE FOR REFERENCE
PROPERTY (ALL MATERIALS) SILICON FOR
MATERIALS) SILICON
GENERATION-RECOMBINATION>IMPACT IONIZATION

a factor, electrons, an v 0.426 1/V Ref. 3
impact ionization

a factor, holes, ap 1A% 0.243 I/V Ref. 3
impact ionization

b factor, electrons, bn Vim 48] IO5 v/ Ref. 3
impact ionization cm

b factor, holes, bp Vim 6.53-10° V/ Ref. 3
impact ionization cm

c factor, electrons, cn [/KValues 3.05-10% I/K  Ref. 3
impact ionization

¢ factor, holes, cp 1/K 5.35~IO'4 1/K  Ref. 3
impact ionization

d factor, electrons, dn 1K 68610 I/K  Ref. 3
impact ionization

d factor, holes, dp 1K 567-10% 1/K  Ref. 3
impact ionization

GENERATION-RECOMBINATION>SHOCKLEY-READ-HALL RECOMBINATION

Electron lifetime, taun s 10 us Ref. 4
SRH

Hole lifetime, SRH taup s 10 pus Ref. 4
MOBILITY MODELS>ARORA MOBILITY MODEL

Electron mobility munO_ref_arora mz/(V-s) 1252 cm?/ Ref. 5
reference (Vs)

Hole mobility mupO_ref_arora mZ/(V-s) 407 cm2/(V-s) Ref. 5
reference

Electron mobility mun_min_ref_arora m2/(V-s) 88 cm2/(V-s) Ref. 5
reference minimum

Hole mobility mup_min_ref_arora mz/(V-s) 53.4 cm?/ Ref. 5
reference minimum (Vs)

Electron reference NnO_ref arora I/m3 1.26- |0|7|/ Ref. 5
impurity cm’

concentration
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TABLE 2-15: SEMICONDUCTOR MATERIAL PROPERTIES (ALL MATERIALS) AND VALUES AND REFERENCES FOR

SILICON

PROPERTY GROUP AND  NAME/VARIABLE (ALL  SIUNIT VALUE FOR REFERENCE
PROPERTY (ALL MATERIALS) SILICON FOR
MATERIALS) SILICON
Hole reference NpO_ref_arora I/m3 2.35-10'71/ Ref. 5
impurity cm’

concentration

Alpha coefficient alphaO_arora I 0.88 Ref. 5
Mobility reference betal_arora I -0.57 Ref. 5
minimum exponent

Mobility reference beta2_arora -2.33 Ref. 5
exponent

Impurity beta3_arora 24 Ref. 5
concentration

reference exponent

Alpha coefficient beta4_arora m2/(V's) -0.146 Ref. 5
exponent

Reference Tref _arora K 300 K Ref. 5
temperature

MOBILITY MODELS>CAUGHEY-THOMAS MOBILITY MODEL

Electron alpha alphan0_ct I I.11 Ref. 6
coefficient

Electron alpha betan|_ct 0.66 Ref. 6
exponent

Electron saturation vnO_ct m/s |~I07 cm/s Ref. 6
velocity

Electron velocity betan2_ct -0.87 Ref. 6
saturation exponent

Hole alpha alphap0_ct .21 Ref. 6
coefficient

Hole alpha exponent betapl_ct 0.17 Ref. 6
Hole saturation vpO_ct m/s 8.37-10% cm/s  Ref. 6
velocity

Hole velocity betap2 ct -0.52 Ref. 6
saturation exponent

Reference Tref_ct K 300 K Ref. 6
temperature
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TABLE 2-15: SEMICONDUCTOR MATERIAL PROPERTIES (ALL MATERIALS) AND VALUES AND REFERENCES FOR

SILICON

PROPERTY GROUP AND  NAME/VARIABLE (ALL  SIUNIT VALUE FOR REFERENCE
PROPERTY (ALL MATERIALS) SILICON FOR
MATERIALS) SILICON
MOBILITY MODELS>FLETCHER MOBILITY MODEL

Fletcher mobility Fl_fl 1/(cm-V-s) 1.04x10%2' 1/ Ref. 7
coefficient | (cm-V:s)

Fletcher mobility F2_fl I/m?2 7.45x10'3 1/ Ref. 7
coefficient 2 cm?

Reference Tref fl K 300 K Ref. 7
temperature

MOBILITY MODELS>LOMBARDI SURFACE MOBILITY MODEL

Electron delta deltan_ls Vis 582x 10 Ref 8
coefficient V/s

Electron mobility munl_Is m2/(V-s) 4.75 x Ref. 8
reference 107em?/ (V-s)

Electron mobility mun2_ls mz/(V-s) 1.74 x 10° Ref. 8
reference cm2/(V~s)

Electron alpha alphan_ls | 0.125 Ref. 8
coefficient

Hole delta deltap_ls Vis 205x 104 V/ Ref. 8
coefficient s

Hole mobility mupl_Is mz/(V-s) 9.93 x 107 Ref. 8
reference cm2/(V~s)

Hole mobility mup2_ls mZ/(V-s) 8.84 x 10° Ref. 8
reference cmz/(V~s)

Hole alpha alphap_ls | 0.0317 Ref. 8
coefficient

Reference Tref Is K | K Ref. 8
temperature

Electric field Eref_Is V/m | Viem Ref. 8
reference

Doping Nref_Is l/m3 | 1/em3 Ref. 8
concentration

reference

MOBILITY MODELS>POWER LAW MOBILITY MODEL

Electron mobility munO_pl mz/(V-s) 1448 cm?/ Ref. 5
reference (Vs)
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TABLE 2-15: SEMICONDUCTOR MATERIAL PROPERTIES (ALL MATERIALS) AND VALUES AND REFERENCES FOR
SILICON

PROPERTY GROUP AND  NAME/VARIABLE (ALL  SIUNIT VALUE FOR REFERENCE
PROPERTY (ALL MATERIALS) SILICON FOR
MATERIALS) SILICON
Hole mobility mup0_pl m2/(V-s) 473 cm2/(V-s) Ref. 5
reference

Electron exponent alphan_pl | 2.33 Ref. 5
Hole exponent alphap_pl I 2.23 Ref. 5
Reference Tref_pl K 300 K Ref. 5
temperature

SEMICONDUCTOR MATERIAL

Band gap Eg0 \ .12V Ref. 1
(valid at
300 K)
Effective density of ~ Nc I/m3 2.8x10'% 1/ Ref 1
states, conduction cm
band x(T/300 K)>2
Effective density of Nv I/m?3 1.04x10'% 1/ Ref. 1
states, valence band cm3
x(T/300 K)>2
Electron affinity chi0 \ 405V Ref. 1
Electron mobility mun m2/(V-s) 1450 cm?/ Ref. 1
(V's)
Hole mobility mup m2(V's) 500 cmZ/(V's)  Ref. 1

Solid Mechanics Material Properties

These material property groups for material models in solid mechanics (including their
associated physical properties) can be added to models from the Material window. Most
of these properties are used by the Structural Mechanics Module. The property groups
of the external material are of a special type that depends on the selected interface type

and are not individually documented.

TABLE 2-16: SOLID MECHANICS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT

LINEAR ELASTIC MATERIAL
ANISOTROPIC

Elasticity matrix D Pa

Loss factor for elasticity matrix D eta_ D |
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TABLE 2-16: SOLID MECHANICS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT

ANISOTROPIC, VOIGT NOTATION

Elasticity matrix, Voigt notation DVO Pa
Loss factor for elasticity matrix D, Voigt notation eta_DVo I
BULK MODULUS AND SHEAR MODULUS

Bulk modulus K N/m?
Shear modulus G N/m?
LAME PARAMETERS

Lamé parameter A lambLame N/m?
Lamé parameter p mulLame N/m?2

ORTHOTROPIC

Young’s modulus Evector Pa
Poisson’s ratio nuvector |
Shear modulus Gvector N/m?
Loss factor for orthotropic Young’s modulus eta_Evector I
Loss factor for orthotropic shear modulus eta_Gvector I

ORTHOTROPIC, VOIGT NOTATION

Shear modulus, Voigt notation GvectorVo N/m2
Loss factor for orthotropic shear modulus, Voigt notation eta_GvectorVo |
PRESSURE-WAVE AND SHEAR-WAVE SPEEDS

Pressure-wave speed cp m/s
Shear-wave speed cs m/s
YOUNG’S MODULUS AND POISSON'S RATIO

Young’s modulus E Pa
Poisson’s ratio nu |

YOUNG’S MODULUS AND SHEAR MODULUS

Young’s modulus E Pa
Shear modulus G N/m?
LINEAR VISCOELASTIC MATERIAL

Long-term shear modulus Gv N/m?2
Bulk modulus K N/m?
POROELASTIC MATERIAL

Biot-Willis coefficient alphaB |
Porosity epsilon |
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TABLE 2-16: SOLID MECHANICS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE  SI UNIT
Permeability kappa m?
SAFETY

ISOTROPIC STRENGTH PARAMETERS

Tensile strength sigmat Pa
Compressive strength sigmac Pa
Biaxial compressive strength sigmabc Pa
ISOTROPIC ULTIMATE STRAINS

Ultimate tensile strain epsilont |
Ultimate compressive strain epsilonc |
ORTHOTROPIC STRENGTH PARAMETERS, VOIGT NOTATION

Tensile strengths sigmats Pa
Compressive strengths sigmacs Pa
Shear strengths sigmass Pa
ORTHOTROPIC ULTIMATE STRAINS, VOIGT NOTATION

Ultimate tensile strains epsilonts |
Ultimate compressive strains epsiloncs |
Ultimate shear strains gammass |
ANISOTROPIC STRENGTH PARAMETERS, VOIGT NOTATION

Second rank tensor, Voigt notation F_s I/Pa
Fourth rank tensor, Voigt notation F f m2-54/kg2

e The Structural Mechanics Module User’s Guide and Table 2-19
E}‘ o The Structural Mechanics Module User’s Guide and Table 2-17
* The Fatigue Module User’s Guide and Table 2-18
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Solid Mechanics Material Properties: Nonlinear Structural Materials

Module

These material property groups for material models in solid mechanics using the

Nonlinear Structural Materials Module (including their associated physical properties)

can be added to models from the Material window.

TABLE 2-17: HYPERELASTIC AND ELASTOPLASTIC MATERIAL PROPERTIES

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT
ELASTOPLASTIC MATERIAL

Hardening function sigmagh Pa
Hill’s coefficients Hillcoefficients (m2-s4)/kg2
Initial tensile and shear yield stresses ys N/m?2
Initial yield stress sigmags Pa
Isotropic tangent modulus Et Pa
Kinematic tangent modulus Ek Pa
ARMSTRONG-FREDERICK

Kinematic hardening modulus Ck Pa
Kinematic hardening parameter gammak I
CHABOCHE

Kinematic hardening modulus CkO_cha Pa
LUDWIK

Strength coefficient k_lud Pa
Hardening exponent n_lud |
SWIFT

Reference strain e0_swi |
Hardening exponent n_swi |
VOCE

Saturation flow stress sigma_voc Pa
Saturation exponent beta_voc |
HOCKETT-SHERBY

Steady-state flow stress sigma_hoc Pa
Saturation coefficient m_hoc |
Saturation exponent n_hoc |

CREEP
NORTON
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TABLE 2-17: HYPERELASTIC AND ELASTOPLASTIC MATERIAL PROPERTIES

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT
Creep rate coefficient A_nor I/s
Reference stress sigRef_nor Pa
Stress exponent n_nor |
GAROFALO (HYPERBOLIC SINE)

Creep rate coefficient A_gar I/s
Reference stress sigRef_gar Pa
Stress exponent n_gar |
NABARRO-HERRING

Volume diffusivity D_nav m?/s
Burgers vector b_nav m
Grain diameter dg_nav m
COBLE

lonic diffusivity D_cob m?/s
Burgers vector b_cob m
Grain diameter dg cob m
WEERTMAN

Diffusivity D_wee m?/s
Burgers vector b_wee m
Stress exponent n_wee |
Reference stress sigRef_wee Pa
VISCOPLASTIC MATERIAL

ANAND

Viscoplastic rate coefficient A_ana I/s
Activation energy Q_ana J/mol
Multiplier of stress xi_ana |
Stress sensitivity m_ana |
Deformation resistance saturation coefficient s0_ana Pa
Deformation resistance initial value sa_init Pa
Hardening constant hO_ana Pa
Hardening sensitivity a_ana |
Deformation resistance sensitivity n_ana |
CHABOCHE

Viscoplastic rate coefficient A_cha I/s
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TABLE 2-17: HYPERELASTIC AND ELASTOPLASTIC MATERIAL PROPERTIES

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT
Reference stress sigRef_cha Pa
Stress exponent n_cha |
PREZYNA

Viscoplastic rate coefficient A_per I/s
Reference stress sigRef_per Pa
POROPLASTIC MATERIAL

Initial yield stress sigmags Pa
Shima-Oyane alpha parameter alphaShima |
Shima-Oyane gamma parameter gammaShima |
Shima-Oyane m parameter mShima |
Initial void volume fraction fo |
Ciritical void volume fraction fc |
Failure void volume fraction ff |
Tvergaard correction coefficient ql qIGTN |
Tvergaard correction coefficient q2 q2GTN |
Tvergaard correction coefficient q3 q3GTN |
Maximum void volume fraction fmax I
NONLINEAR ELASTIC MATERIAL

Reference stress sigRef Pa
Reference strain eRef |
Stress exponent n_stress |
Reference shear strain gammaRef |
Strain exponent n_strain |
Bulk modulus in tension Kt Pa
Bulk modulus in compression Kc Pa
Ultimate deviatoric stress q_ult Pa
Ultimate strain e_ult |

ELASTOPLASTIC SOIL MATERIAL

CAM-CLAY
Swelling index
Compression index

Void ratio at reference pressure

kappaSwelling
lambdaComp

evoidref
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TABLE 2-17: HYPERELASTIC AND ELASTOPLASTIC MATERIAL PROPERTIES

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT
Slope of critical state line M |
STRUCTURED CAM-CLAY

Swelling index for structured clay kappaSwellingS |
Compression index for destructured clay lambdaComp$S I
Void ratio at reference pressure for destructured evoidrefS |
clay

Destructuring index for volumetric deformation dvS I
Destructuring index for shear deformation dsS |
Slope of critical state line M |
Additional void ratio at initial yielding Deltaei |
Initial structure strength pbi Pa
Plastic potential shape parameter zeta$S |
Ciritical effective deviatoric plastic strain epdevc |
BARCELONA BASIC

Swelling index kappaSwelling |
Swelling index for changes in suction kappaSwellings |
Compression index at saturation lambdaComp0 I
Weight parameter wB |
Soil stiffness parameter mB Pa
Plastic potential smoothing parameter bB |
Tension to suction ratio kB |
Void ratio at reference pressure and saturation evoidref0 I
Initial yield value for suction sy0 Pa
HARDENING SOIL

Reference stiffness for primary loading E50Ref Pa
Reference stiffness for unloading and reloading EurRef Pa
Stress exponent mH |
Bulk modulus in compression Kc Pa
Void ratio at reference pressure evoidref |
HYPERELASTIC MATERIALS

ARRUDA-BOYCE

Macroscopic shear modulus mu0 N/m?2
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TABLE 2-17: HYPERELASTIC AND ELASTOPLASTIC MATERIAL PROPERTIES

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT
Number of segments Nseg |
BLATZ-KO

Model parameters phiBK |
Model parameters betaBK |
Shear modulus muBK Pa
GAO

Model parameters aG Pa
Model parameters nG |
GENT

Macroscopic shear modulus muG Pa
Model parameters imG |

MOONEY-RIVLIN

Model parameters CO0l, C02, C03, Pa
Clo, Cl1, Cl2,
C20, C21, C30
MURNAGHAN The Murnaghan node adds five

model parameters. The model is
based on strain invariants and is
typically used in acoustoelasticity.

Murnaghan third-order elastic moduli I Pa
Murnaghan third-order elastic moduli m Pa
Murnaghan third-order elastic moduli n Pa
Lamé parameter A lambLame Pa
Lamé parameter p mulLame Pa
VARGA

Model parameters clVA Pa
Model parameters c2VA Pa
YEOH

Model parameters clYE Pa
Model parameters c2YE Pa
Model parameters c3YE Pa
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Solid Mechanics Material Properties: Fatigue Module

These material property groups for material models in solid mechanics using the
Fatigue Module (including their associated physical properties) can be added to

models from the Material window.

TABLE 2-18: ELASTOPLASTIC AND FATIGUE BEHAVIOR MATERIAL PROPERTIES

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT
ELASTOPLASTIC MATERIAL>RAMBERG-OSGOOD

Cyclic hardening coefficient K_ROcyclic Pa
Cyclic hardening coefficient n_ROcyclic I
FATIGUE BEHAVIOR>ENERGY-BASED

DARVEAUX

Crack initiation energy coefficient KI|_Darveaux I
Crack initiation energy exponent  k2_Darveaux I
Crack propagation energy K3_Darveaux m
coefficient

Crack propagation energy k4_Darveaux I
exponent

Reference energy density Wref_Darveaux j/m3
MORROW

Fatigue energy coefficient Wf_Morrow J/m3
Fatigue energy exponent m_Morrow I
FATIGUE BEHAVIOR>FATIGUE BEHAVIOR>APPROXIMATE S-N CURVE

Transition stress sigmat Pa
Transition life Nt I
Endurance life Ne |
FATIGUE BEHAVIOR>GENERAL

Endurance limit sigmae Pa
FATIGUE BEHAVIOR>STRAIN-BASED

COFFIN-MANSON

Fatigue ductility coefficient epsilonf_CM I
Fatigue ductility exponent < CM I
Shear fatigue ductility coefficient =~ gammaf_CM I

Shear fatigue ductility exponent

FATEMI-SOCIE

cgamma_CM

OTHER MATERIAL PROPERTIES REFERENCE

95



TABLE 2-18: ELASTOPLASTIC AND FATIGUE BEHAVIOR MATERIAL PROPERTIES

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT
Normal stress sensitivity k_FS |
coefficient

WANG-BROWN

Normal stress sensitivity S_WB |
coefficient

FATIGUE BEHAVIOR>STRESS-BASED

BASQUIN

Fatigue strength coefficient sigmaf_Basquin Pa
Fatigue strength exponent b_Basquin I
Shear fatigue strength coefficient  tauf_Basquin Pa
Shear fatigue strength exponent bgamma_Basquin |
FINDLEY

Normal stress sensitivity k_Findley |
coefficient

Limit factor f_Findley Pa
MATAKE

Normal stress sensitivity k_Matake |
coefficient

Limit factor f_Matake Pa
NORMAL STRESS

Limit factor f_NormalStress Pa
DANG VAN

Hydrostatic stress sensitivity a_DangVan |
coefficient

Limit factor b_DangVan Pa

Solid Mechanics Material Properties: Geomechanics Material Model

These material property groups for material models in solid mechanics (including their
associated physical properties) can be added to models from the Material window.
These property groups are used by the Geomechanics Module.

TABLE 2-19: GEOMECHANICS MODELS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT

DRUCKER-PRAGER

Drucker-Prager alpha coefficient  alphaDrucker
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TABLE 2-19: GEOMECHANICS MODELS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT
Drucker-Prager k coefficient kDrucker Pa
HOEK BROWN

Hoek-Brown m parameter mHB I
Hoek-Brown s parameter sHB I
Geological strength index GSlI |
Disturbance factor Dfactor |
Intact rock parameter miHB I
LADE-DUNCAN

Lade-Duncan k coefficient kLade

MATSUOKA-NAKAI

Matsuoka-Nakai mu coefficient muMatsuoka |
MOHR-COULOMB

Cohesion cohesion Pa
Angle of internal friction internalphi rad
OTTOSEN

Ottosen a parameter aOttosen I
Ottosen b parameter bOttosen I
Size factor k1Ottosen I
Shape factor k2Ottosen I
YIELD STRESS PARAMETERS

Uniaxial tensile strength sigmaut Pa
Uniaxial compressive strength sigmauc Pa
Biaxial compressive strength sigmabc Pa

Thermal Expansion Material Properties

This material property group for thermal expansion properties can be added to models

from the Material page.

TABLE 2-20: THERMAL EXPANSION MATERIAL PROPERTIES

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT
IDEAL GAS

Isotropic tangent coefficient of thermal  alphatanlso I/K
expansion

Isotropic thermal strain dLIso I

OTHER MATERIAL PROPERTIES REFERENCE
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TABLE 2-20: THERMAL EXPANSION MATERIAL PROPERTIES

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SIUNIT

Tangent coefficient of thermal expansion alphatan_iso; alphatanij  I/K

Thermal strain dLi_iso, dLij |

External Material Properties

The property groups of the external materials are of a special type that depends on the
selected interface type and are not individually documented. You can incorporate as
many parameters in the call to the external DLL when you add an external material,
these parameters will appear in the Material node as material inputs, see Working with

External Materials for more information.
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Using Functions

The Material Library describes material properties with functions, usually functions of
temperature, and for this purpose it uses piecewise analytic functions (polynomials).
For user-defined property functions, three types of functions can be defined: analytic
functions, piecewise analytic functions, and interpolation functions.

Functions are useful for describing material properties as, for example, functions of
temperature or pressure.

Adding a Function to the Material

Material functions are either automatically added to the Model Builder sequence
(usually with materials from the material library) or functions can be added based on
individual requirements.

I Add a material to the Component node (see The Material Browser Window and The
Add Material Window).

2 Add an Analytic (f':f' ), Interpolation (), or Piecewise ( ",) function.

To add an Analytic ( f'}' ), Interpolation (- ), or Piecewise (™, ) function:

¢ On the Materials toolbar, click Analytic, Interpolation, or Piecewise.

* Right-click a property group node (for example, Basic) and select a
function from the Functions list.

To add an Analytic ( f'}' ), Interpolation (- ), or Piecewise (", ) function:
* Right-click a property group node, for example, Basic and select a
function from the Functions list.

¢ On the Materials contextual toolbar, click Analytic, Interpolation, or
Piecewise.

USING FUNCTIONS
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- Select Analytic to add an analytic function of one or more input arguments.

- Select Interpolation to add an interpolation function that can interpolate from
structured data (defined on a grid) or unstructured data (defined on a generic
point cloud).

- Select Piecewise to add a piecewise function that is useful if a material property has
different definitions on different intervals. The intervals must not overlap, and

there cannot be any holes between intervals.

* Defining an Analytic Function

@ * Analytic, Interpolation, and Piecewise in the COMSOL Multiphysics
Reference Manual

Once a function is created, you can use it for any property in the same

g property group.

Defining an Analytic Function

Assume that you want to define the density py for a material as a function of pressure
and temperature: p1=p1(p,T’). You can name the function rhot (p,T) and use the
expression p*0.02897/8.314/T to define the function.

I On the Materials toolbar, click the Browse Materials [:;;|, Add Material or Blank

Material :Z: button to add a new material to the Component (or use an existing

] >

material where density is not defined, or redefine the current expression for the

density).
2 Add a Density property to the material.
a In the Model Builder, click the Material node.

b In the Settings window for Material, click to expand the Material Properties

section. Under Basic Properties, right-click Density and Add to Material.
A Density property is added to the Basic property group.

3 In the Model Builder, under the material node, right-click Basic and select
Functions>Analytic. This adds an Analytic subnode ( f'}') under Basic.

4 On the Settings window for Analytic, enter rho1 in Function name. Replace the

default name.
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5 Under the Definition section:

a In the Expression ficld, enter p*0.02897/8.314/T.

b In the Arguments column, enter p,T.

6 Under Units:

a In the Arguments ficld, enter Pa, K as the units for the pressure and the

temperature, respectively.

b In the Function field, enter kg/m~3 as the unit for the function’s output (density).
The function rho1 can now be used to define the density in your material.

Settings

Analytic
Plot & Create Plot

Label: Analytic 1

Function name:  rhol

¥ Definition

Expression:  p*0.02897/8.314/T

Arguments: p, T

Derivatives: Automatic
Periodic Extension

¥ Units

Arguments:  Pa, K

Function: kg/m*3
Advanced

Plot Parameters

7 Click the Material node. In the Settings window for Material, under Material Contents,

enter rho1(p,T) in the Value column (in the Density row).

¥ Material Contents

Property
@ Young's modulus
@ Poisson's ratio
[ Density

Variable Value

Property group
Basic
Basic
Basic

Click the Basic node to notice that the Density analytic function is defined in the
Settings window for Property Group under Output Properties. The expression will be
orange if there are no variables p and T for pressure and temperature, respectively,

defined in the component. See Figure 2-13.
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Settings

Property Group

Label: Basic =
¥ Output Properties
" Property Variable  Expression Unit Size  Info
Density rho rhol(p,T) kg/m* 1l
+ v
Expression:

Figure 2-13: A density property is defined using an analytic function.
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